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Introduction to the application

D-PHY Application Overview
TekExpress is the Tektronix Test Automation Framework, developed to support
your current and future test automation needs. TekExpress uses a highly modular
architecture that lets you deploy automated test solutions for various standards in
a relatively short time.

Key Features The key features of the D-PHY application are:

■ Allows conformance testing to the latest Compliance Test Specification
(Base Spec 1.2)

■ Comprehensive test coverage performing all conformance tests to the latest
CTS. (100% test coverage)

■ Fully-automated Multi-lane testing using an external RF switch
■ Automated testing:

■ Eliminates user intervention to conduct time-consuming testing
■ Reduces the time required to conduct testing
■ Enables you to test devices faster

■ Automated temperature chamber testing provides automated setup to validate
all High Speed tests using XL cables, temperature tips and standard filter
files

■ Customizing the setup:

■ Allows you to modify the test setup as per the DUT configuration
■ Automatically calculates unit intervals based on the DUT data rates

■ Margin testing and characterization:

■ Allows custom-limits or limits-editing to perform Margin testing
■ Performs characterization of your design

■ Flexible probing allows you to probe your Device Under Test (DUT) using
either Differential or Single-ended probes.

■ Selective testing:

■ Performs fully-automated testing for transmitter measurements
■ Allows you to select individual tests or test groups in the tree-structure
■ Avoids repeated testing, through accurate and reliable results from a

single run
■ Escape mode support allows you to perform both Escape Mode (ULPS

Mode) and the Normal Mode tests

TekExpress D-PHY Printable Application Help 1



■ Clock Continuous Mode support allows you to perform all tests in normal
mode or selective tests in Clock Continuous mode

■ Detailed test reporting:

■ Provides a Pass/Fail summary table
■ Provides margin details on each test
■ Provides a consolidated report for all tests

Related documentation
The following manuals are available as part of the TekExpress D-PHY
Automated Solution documentation set.

Table 1: Product documentation

Item Purpose Location
Online Help In-depth operation and UI help.

PDF of the Online Help
(077-0514-XX)

In-depth operation and UI help.

Conventions
Online Help uses the following conventions:

■ The term “DUT” is an abbreviation for Device Under Test.

■ The term “select” is a generic term that applies to the two mechanical
methods of choosing an option: using a mouse or using the touch screen.

■ A Note identifies important information.
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Technical support
Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):

General Information ■ All instrument model numbers.
■ Hardware options, if any.
■ Probes used.
■ Your name, company, mailing address, phone number, FAX number.
■ Please indicate if you would like to be contacted by Tektronix about your

suggestion or comments.

Application Specific
Information

■ Software version number.
■ Description of the problem such that technical support can duplicate the

problem.
■ If possible, save the setup files for all the instruments used and the

application.
■ If possible, save the TekExpress setup files, log.xml , *.TekX (session files

and folders), and status messages text file.
■ If possible, save the waveform on which you are performing the

measurement as a .wfm file.

Forward the information to technical support using one of these methods:

■ E-mail – techsupport@tektronix.com
■ FAX – (503) 627-5695

 Introduction to the application
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Getting started

Compatibility
The TekExpress D-PHY application runs on the following Tektronix
oscilloscopes:

■ MSO70404C, MSO70604C, MSO70804C, MSO71254C, MSO71604C, and
MSO72004C Series Mixed Signal Oscilloscopes

DPO/DSA70404C, DPO/DSA70604C, DPO/DSA70804C, DPO/
DSA71254C, DPO/DSA71604C, and DPO/DSA72004C Series Digital
Oscilloscopes

■ MSO70404, MSO70604, MSO70804, MSO71254, MSO71604, and
MSO72004 Series Mixed Signal Oscilloscopes

■ DPO/DSA70404B, DPO/DSA70604B, DPO/DSA70804B, DPO/
DSA71254B, DPO/DSA71604B, and DPO/DSA72004B Series Digital
Oscilloscopes

■ DPO/DSA70404, DPO/DSA70604, DPO/DSA70804, DPO/DSA71254,
DPO/DSA71604, and DPO/DSA72004 Series Digital Oscilloscopes

■ DPO7254C  1 and DPO7354C Digital Oscilloscope

■ DPO72541 and DPO7354 Digital Oscilloscope

The TekExpress D-PHY application supports the following Tektronix probes:

■ TAP1500

■ P7240

■ P6245

■ P7380A

■ P7508 (supports HS-tests only, with known limitations for DSI DUTs)

■ P7313 (used for 33G models)

■ TDP3500

1 The DPO7254/C oscilloscope may not meet the Rise/Fall time specifications of D-PHY standards. If that is not
critical, then you can use the DPO7254/C oscilloscope for the D-PHY measurement.
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Minimum system requirements
The minimum system requirements for a PC to run TekExpress are as follows:

Item Requirement
Processor Pentium 4/M or equivalent processor.
Operating System Windows XP Service Pack 2, Windows 7.
Memory 512 MB of memory.
Hard Disk Approximately 2 GB of available hard-disk space for the recommended

installation, which includes full TekExpress installation and distributed
components.

Drive DVD drive.
Display Super VGA resolution or higher video adapter (800x600 minimum video

resolution for small fonts or 1024x768 minimum video resolution for large
fonts). The application is best viewed at 96 dpi display settings  2.

Software ■ Microsoft Excel 2002 or above.

■ Microsoft Internet Explorer 6.0 SP1 or later.

■ Microsoft Photo Editor 3.0 or equivalent software for viewing image
files.

■ Adobe Reader 6.0 or equivalent software for viewing portable
document format (PDF) files.

Other Devices ■ Microsoft compatible mouse or compatible pointing device.

■ Four USB ports (two USB ports minimum).

■ PCI-GPIB or equivalent interface for instrument connectivity  3.

2 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, sampling
oscilloscope), it is recommended to connect a secondary monitor and this must be enabled before launching the
application.

3 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port will be used by TekExpress for
communicating with oscilloscope applications. If external GPIB communication devices like USB-GPIB-HS or
equivalent are used for instrument connectivity, ensure that the Talker Listener utility is enabled in the DPO/DSA
oscilloscope's GPIB menu. For ease of use, connect to an external (secondary) monitor.
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Install the software
1. Close all applications.

2. Download D-PHYWebinstaller_<version>.EXE.

3. Double-click the executable to extract the files. After extraction, the installer
launches and the software is installed in C:\Program Files (x86)\Tektronix
\TekExpress\TekExpress D-PHY.

Application directories and usage
The application directory and associated files are organized as follows:
 

 

The following table lists the default directory names and their usage:

Directory names Usage
InstallDir\TekExpress
\TekExpress D-PHY

Contains the application and associated files.

TekExpress D-PHY\Compliance
Suites

Contains compliance specific files.

TekExpress D-PHY\Bin
TekExpress D-PHY\Lib
TekExpress D-PHY\Tools

Includes the Miscellaneous libraries of the D-PHY application.
Includes utility files specific to the D-PHY application.
Includes instrument application specific files for the D-PHY
application.

TekExpress D-PHY\ACP
TekExpress D-PHY\SCP
TekExpress D-PHY\ICP

Includes instrument and application specific interface libraries of
the D-PHY application.

TekExpress D-PHY\Documents Includes the technical documentation for the application.

 Getting started
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Directory names Usage
TekExpress D-PHY\Data
Manager
TekExpress D-PHY\Data
Storage
TekExpress D-PHY\Report
Generator

Includes the result management specific libraries of the D-PHY
application are present in these folders.
Includes Excel Active X interface Library for Report Generation.

TekExpress D-PHY
\Filter_Files_for_Temperature_
Chamber

Includes the filter files for the D-PHY application.

Folder structure
After you install D-PHY, it creates the following folders on your computer:

■ \Program Files (x86)\Tektronix\TekExpress\TekExpress D-PHY.

NOTE. Ensure that the “TekExpress” folder has read and write access.

■ \My Documents\My TekExpress\D-PHY.

■ \My Documents\My TekExpress\D-PHY\Untitled Session.

Every time the TekExpress D-PHY.exe is launched, an Untitled Session
folder is created under D-PHY folder. The Untitled Session folder is deleted
when you exit the D-PHY application.

CAUTION. Each session has multiple files associated with it. Do not modify
any of the session files and/or folders as this may result in loss of data or
corrupted session files.

■ The My TekExpress folder is created as a shared folder with share name as
<domain><user ID>My TekExpress (or if the PC is not connected to domain,
then share name is <Computer name><user ID> My TekExpress).

■ The above shared folder is mapped as X: (X drive) on to the instrument
where D-PHY is running.

NOTE. If X drive is mapped to any other shared folder, the application will
display a warning message window asking you to disconnect the X: drive
manually.

Getting started  
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File name extensions
The software uses the following file name extensions:

File name extension Description
.TekX The session file will be saved in this format.
.seq The test sequence file.
.xml The encrypted XML file that contains the test specific

configuration information.
The log file extension is also xml.

.wfm The test waveform file.

.mht The test result report will be saved in this format.

.flt The filter files are in this format.

Activate the license
Follow the steps below to activate the license:

1. Click Help > Activate License > License Info to view the license
information and activate the application.

2. Click Help> About Tekexpress > View Version Details link to view the
Version Details.
 

 

 Getting started
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3. Click the View End-User License Agreement link to open the following
Tektronix Software License Agreement window. Click Print to print the
License Agreement.
 

 
4. Click License Info to view the available software options. This window

shows the license key and supported options with their status (active or
inactive) with the current license key.
 

 
5. If you are activating the license for the first time, the license key field will be

empty. To activate the license, connect the USB dongle to your computer,
enter the license key provided in the license key certificate, and click
Activate. If the activation is successful, a sign is displayed next to the license
key field.

6. If you are reactivating the license, click Reactivate, enter the new license key
and click Activate.

Getting started  
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Before you click run
Do the following before you click Run:

NOTE. Ensure that the network connectivity is enabled on the instrument running
the D-PHY application.

1. Map the shared My TekExpress folder as X: (X drive) on all the instruments
used in test setup running Microsoft Windows Operating System. This shared
folder is used to save the waveform files or used during any other file transfer
operations.

Mapping My TekExpress Folder

To map the My TekExpress folder on the instruments, follow the steps below:

a. Open Windows Explorer.

b. From the Windows Explorer menu, select Tools > Map Network drive.

c. Select the Drive letter as X: (if there is any previous connection on X:,
disconnect it first through Tools > Disconnect Network drive menu of
Windows Explorer).

d. In the Folder field, enter the remote My TekExpress folder path (for example,
\\192.158.97.65\ John’s My TekExpress)

e. To determine the IP address of the PC where “My TekExpress” folder exists,
do the following:

■ Select Start > Run menu on the PC where the My TekExpress folder
exists.

■ Enter cmd and press Enter.

■ At the command prompt, type ipconfig.

2. Right-click on the My TekExpress folder and open the Properties dialog
box. Select the General tab and then Advanced. In the Advanced
Attributes window, ensure that the option Encrypt contents to secure data
is NOT selected. Click here to view the picture.

 Getting started
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3. Ensure that all the required instruments are properly warmed up, Signal Path
Compensation (SPC) performed, followed by cable deskew.

To find SPC, do the following:

a. On the oscilloscope main menu, select the Utilities menu.

b. Click the Instrument Calibration option.

Getting started  
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Operating basics

Starting the application
The application uses a USB dongle that contains the license key. This dongle
must be present on the instrument hosting the D-PHY application.

The application also checks for a file, called Resources.xml, located in My
TekExpress folder. If this file is not found, instrument discovery is performed
before launching D-PHY. The Resources.xml file contains information regarding
instruments available on network.

When the application starts, it checks for the appropriate license key. If the valid
license key is not present, the application switches to the “Evaluation” mode. If
the application fails to detect the dongle, it continues to run in Evaluation mode.

Start the application in one of the following ways:

■ Click Start > Programs > Tektronix > TekExpress > TekExpress D-PHY.

■

Double click the icon on the desktop.

■ If you have previously saved a session, double-click the session file stored
under My TekExpress\D-PHY.

 

 

NOTE. If the application was not terminated properly during the last use, a dialog
box asks to recall the previously unsaved session.
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Resizing the application window

To minimize the application, click  on the application title bar. To restore the

application to its previous size, select  in the Windows task
bar.

To maximize the application, click . To restore the application to its previous
size, click on the application title bar.

Exiting the application
To exit the application, do one of the following: 

■ Click File > Exit.
■

Click  on the application title bar.

NOTE. Using other methods to exit the application results in abnormal
termination of the application.

Global controls
The menus and controls that appear outside the individual tabs are called “Global
Controls”. These are used to specify the devices to be tested.
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14  TekExpress D-PHY Printable Application Help



Table 2: Global controls

Control name Function
DUT The device ID is specified at the global level and the information is stored

in the default location for all data files. This field cannot be empty and
does not allow these special characters (.,..,...,\,/:?”<>|*). The maximum
length of characters allowed is 32.
Displays the status of the disk space. When the disk space is low, a
warning dialog appears to perform the cleanup and continue working on
the application.

 

 

You will be able to run, pause, resume, and stop the tests.

Menus

File menu Click File on the application menu bar.

 

 

The File menu has the following selections:

Menu Function
New Session Starts a default session of D-PHY.
Open Session Opens a saved session.
Save Session Saves the session.
Save Session As Saves a session in a different name.
Recently Recalled Setup Recalls the recently saved setup.

 Operating basics
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Menu Function
Save Report As Saves the report in user specified location.
Print Preview Report Previews the report before printing.
Print Report Opens the Windows “Print” dialog box.
Exit Closes the application.

View menu Click View on the application menu bar.

 

 

The View menu has the following selections:

Menu Function
Log Opens the log (log.xml) file in the default viewer.

Tools menu Click Tools on the application menu bar.

 

 

The Tools menu has the following selections:

Menu Function
Instrument Bench Shows the list of instruments connected to the test setup.
E-mail Setting Allows you to configure and set the e-mail options.

Operating basics  
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Instrument Bench The Instrument Bench window shows the list of VISA and Non-VISA resources
found on different interfaces/connections. It serves two purposes at the launch of
TekExpress:

■ Discovers the connected instruments.
■ Confirms the instrument connection setup.

When you click Tools > Instrument Bench, the following dialog box is
displayed:
 

 

E-mail Settings The E-mail Settings utility allows you to configure and set the e-mail options.
The following fields are mandatory for receiving e-mail notification from
TekExpress:

1. Recipient Email Addresses. For example, User@domain.com
2. Sender's Address
3. SMTP Server address of the Mail server configured at client location

If any of the above mentioned fields are left blank, the settings will not get saved
and e-mail notification will not be sent.
 

 Operating basics
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Check the option “E-mail Test Results When Complete or on Error” to receive
the e-mail. The attachment list depends on the choice which is made while
configuring the email setup.

NOTE. The Analysis Screenshot option in the Add Email Attachments pane is not
yet functional.

Help menu Click Help on the application menu bar.

 

 

The Help menu has the following selections:

Menu Function
TekExpress Help Displays TekExpress Help (F1).
About TekExpress Displays the TekExpress screen with the application title. Also displays

the application details such as software name, version number, and
copyright.

Activate license Displays the details of activating the application.

Operating basics  
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How to

Select test(s)
The application supports the following D-PHY tests:

■ Group 1 tests that are Single-ended tests and available only in the Escape
mode:

1.1.1 Data Lane LP-TX Thevenin Output High Level Voltage (VOH)
(Single-ended only)

1.1.2 Data Lane LP-TX Thevenin Output Low Level Voltage (VOL) (Single-
ended only)

1.1.3 Data Lane Rise Time (Single-ended only)

1.1.4. Data Lane Fall Time (Single-ended only)

1.1.5. Data Lane LP-TX Slew Rate versus CLOAD (ōVō/tSR) (Single-ended
only)

1.1.6. Data Lane LP-TX Pulse Width of Exclusive-OR Clock (TLP-PULSE-
TX) (Single-ended only)

1.1.7. Data Lane LP-TX Period of Exclusive-OR Clock (TLP-PER-TX)
(Single-ended only)

NOTE. Group 1 tests are supported on LP-HS waveforms although it is not
recommended to use LP-HS waveforms for these tests.

■ Group 2 tests that are Single-ended tests and available only in the Escape
mode:

1.2.1 Clock Lane LP-TX Thevenin Output High Level Voltage (VOH)
(Single-ended only)

1.2.2 Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL)
(Single-ended only)

1.2.3 Clock Lane Rise Time (Single-ended only)

1.2.4. Clock Lane Fall Time (Single-ended only)

1.2.5. Clock Lane LP-TX Slew Rate versus CLOAD (ōV/ōtSR) (Single-
ended only)

NOTE. Group 2 tests are supported on LP-HS waveforms although it is not
recommended to use LP-HS waveforms for these tests.
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■ Group 3 tests:

The following Group 3 tests are single-ended and differential tests, except
where indicated:

1.3.1 Data Lane HS Entry: Data Lane TLPX Value (Single-ended only)

NOTE. The Data Lane HS Entry: Data Lane TLPX Value test is supported on
LP-HS waveforms although it is not recommended to use LP-HS waveforms
for this test.

1.3.2 Data Lane HS Entry: THS-PREPARE Value

1.3.3 Data Lane HS Entry: THS-PREPARE + THS-ZERO Value

1.3.4 Data Lane HS-TX Differential Voltages (VOD(0), VOD(1))

1.3.5 Data Lane HS-TX Differential Voltage Mismatch (ΔVOD)

1.3.6 Data Lane HS-TX Single-ended Output High Voltages (VOHHS(DP)),
VOHHS(DN)) (Single-ended only)

1.3.7 Data Lane HS-TX Common Mode Voltages (VCMTX(1), VCMTX(0))

1.3.8 Data Lane HS-TX Common Mode Voltage Mismatch (ΔVCMTX(1,0))

1.3.9 Data Lane HS-TX Dynamic Common-Level Variations Between 50–
450MHz (ΔVCMTX(HF))

1.3.10 Data Lane HS-TX Dynamic Common-Level Variations Above
450MHz (ΔVCMTX(HF))

1.3.11 Data Lane HS-TX 20%–80% Rise Time (tR)

1.3.12 Data Lane HS-TX 80%–20% Fall Time (tF)

1.3.13 Data Lane HS Exit: THS-TRAIL Value

1.3.14 Data Lane HS Exit 30%–80% POST-EoT Rise Time (TREOT)

1.3.15. Data Lane HS Exit: TEOT Value

1.3.16. DATA Lane HS Exit: THS-EXIT Value

■ Group 4 tests:

The following Group 4 tests are single-ended and differential tests, except
where indicated:

1.4.1 Clock Lane HS Entry: TLPX Value (Single-ended only)

1.4.2 Clock Lane HS Entry: TCLK-PREPARE Value (Single-ended only)

1.4.3 Clock Lane HS Entry: TCLK-PREPARE + TZERO Value (Single-
ended only)

1.4.4 Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1))

1.4.5 Clock Lane HS-TX Differential Voltage Mismatch (ΔVOD)
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1.4.6 Clock Lane HS-TX Single-ended Output High Voltages
(VOHHS(DP)), VOHHS(DN)) (Single-ended only)

1.4.7 Clock Lane HS-TX Common Mode Voltages (VCMTX(1),
VCMTX(0)) (Single-ended only)

1.4.8 Clock Lane HS-TX Common Mode Voltage Mismatch
(ΔVCMTX(1,0)) (Single-ended only)

1.4.9 Clock Lane HS-TX Dynamic Common-Level Variations Between 50–
450MHz (ΔVCMTX(LF)) (Single-ended only)

1.4.10 Clock Lane HS-TX Dynamic Common-Level Variations Above
450MHz (ΔVCMTX(HF)) (Single-ended only)

1.4.11 Clock Lane HS-TX 20%–80% Rise Time (tR)

1.4.12 Clock Lane HS-TX 80%–20% Fall Time (tF)

1.4.13 Clock Lane HS Exit: TCLK-TRAIL Value (Single-ended only)

1.4.14 Clock Lane HS Exit 30%–80% POST-EoT Rise Time (TREOT)
(Single-ended only)

1.4.15. Clock Lane HS Exit: TEOT Value (Single-ended only)

1.4.16. Clock Lane HS Exit: THS-EXIT Value (Single-ended only)

1.4.17 Clock Lane HS Clock Instantaneous (UIINST)

1.4.18 Clock Lane HS Clock Delta UI (ΔUI)

■ Group 5 tests:

The following Group 5 tests are single-ended and differential tests, except
where indicated:

1.5.1 HS Entry: TCLK PRE Value

1.5.2 HS Exit: TCLK POST Value

1.5.3 HS Clock Rising Edge Alignment to First Payload Bit

1.5.4. Data-to-Clock Skew (TSKEW[TX])

1.5.5. Initial HS Skew Calibration Burst (TSKEWCAL-SYNC,
TSKEWCAL)

1.5.6. Periodic HS Skew Calibration Burst (TSKEWCAL-SYNC,
TSKEWCAL)

NOTE. Group 5 tests are not available in the Clock Continuous mode.
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The following table lists the tests (ids) that are supported in the clock and test
modes:

Clock mode Test mode Test ids
Normal Normal Single-ended tests: Group 3, Group 4, and Group 5.

Test ids: 1.3.1, 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.6, 1.3.7,
1.3.8, 1.3.9, 1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14,
1.3.15, 1.3.16.
Test ids: 1.4.1, 1.4.2, 1.4.3, 1.4.4, 1.4.5, 1.4.6, 1.4.7,
1.4.8, 1.4.9, 1.4.10, 1.4.11, 1.4.12, 1.4.13, 1.4.14,
1.4.15, 1.4.16, 1.4.17, 1.4.18.
Test ids: 1.5.1, 1.5.2, 1.5.3, 1.5.4, 1.5.5, 1.5.6.
Differential tests: Group 3, Group 4, and Group 5.
Test ids: 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.7, 1.3.8, 1.3.9,
1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14, 1.3.15, 1.3.16.
Test ids: 1.4.4, 1.4.5, 1.4.11, 1.4.12, 1.4.17,1.4.18.
Test ids: 1.5.1, 1.5.2, 1.5.4.

Normal Escape Single-ended tests: Group 1, Group 2, and Group 3.
Test ids: 1.1.1, 1.1.2, 1.1.3, 1.1.4, 1.1.5, 1.1.6, 1.1.7 Test
ids: 1.2.1, 1.2.2, 1.2.3, 1.2.4, 1.2.5.
Test id: 1.3.1 

Continuous Normal Single-ended tests: Group 3 and Group 4.
Test ids: 1.3.1, 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.6, 1.3.7,
1.3.8, 1.3.9, 1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14,
1.3.15, 1.3.16.
Test ids: 1.4.4, 1.4.5, 1.4.6, 1.4.7, 1.4.8, 1.4.9, 1.4.10,
1.4.11, 1.4.12, 1.4.17, 1.4.18.
Differential tests: Group 3 and Group 4.
Test ids: 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.7, 1.3.8, 1.3.9,
1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14, 1.3.15, 1.3.16.
Test ids: 1.4.4, 1.4.5, 1.4.11, 1.4.12, 1.4.17.
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Use the Select panel to select configure, and run one or more groups of tests.
 

 

Select Device. Select the device type from the list: D-PHY CSI-2 or D-PHY DSI.
The default value is D-PHY-CSI-2. Enter the DUT ID for the device.

Select Clock Mode. Select the Clock Mode: Normal or Continuous. Select
Continuous when the signal has only the high speed region. Select Normal when
the signal has both, the high speed and the low power regions. The application
uses Edge trigger for Continuous mode and Transition trigger for Normal mode.
The default Sample rate is 12.5 Gs/s and the default Record Length is 1M.

Select Clock Lane Probing. Select the probing method: Differential or Single-
Ended. Based on this selection, the application displays the single-ended and
differential tests. If probing type is Single-ended then you will need four probes
(Dp, Dn, Clkp, Clkn). If probing type is Differential, then you will need three
probes (Dp, Dn, Clkp-Clkn). Group 1 and Group 2 tests are not available for the
Differential probing method

Select Lanes to Test. Select the lane to test. You can manually select the lanes to
test, or you can select Automate Lane Switching with RF switch. If you select
multiple lanes without automation, a control window is displayed when you need
to switch the probing to the next lane. If you select automated lane switching, the
system automatically switches to the next lanes for you.
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Select Test Mode. Select the test mode from the list: Normal or Escape. The
default value is Normal. Escape is available only when the Clock Mode is
Normal. The application does not support Clock continuous mode for Escape
mode tests. As a result, the trigger is Transition trigger. When you select Escape
mode, you must connect a ULPS signal to the oscilloscope on which the
measurements will be done. However, the application can still perform the
measurements on the LP-HS signals. The default Sample rate is 12.5 Gs/s and the
default Record Length is 1M.

Version. Select the Compliance Test Specification version, the default value is
Base Spec 1.2. For the selected CTS version, select any particular test, or one or
more test groups.

Table 3: Select panel buttons

Button Description
Opens the configuration panel for the selected test.

Opens the schematic for the selected test. This is useful if you want to verify the test
setup before running the test.
Selects all tests in the table.

Deselects all tests in the table.
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Configure and run the test(s)
The configuration panel is used to view and edit the parameters associated with
the acquisition and the analysis of the selected test. Click here for the options.
 

 

NOTE. If any of the test parameters are grayed, it means that these parameters
are not editable.

The upper part of the Configuration Panel shows parameters and their values.
These parameters are common for a group of tests. Parameters specific to a select
test are shown in the lower part of the Configuration Panel. Test-specific
parameters include acquisition, analysis, and limit parameters.

The following table lists the common parameters and their values:
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Table 4: Common parameters and values

Parameter Value
Real Time Scope Select the oscilloscope to which to connect.
Measurement Method Select the measurement method: Automatic or

Manual. In the Automatic mode, you perform a
test without any intervention. In the Manual
mode, you will be prompted to place the cursors
on the acquired waveform before the application
proceeds with the analysis.

NOTE. The Manual method is available only in
the User Defined mode.

Filter File 1 (for testing in Temperature
Chamber) 

Select the filter file to use for temperature
chamber testing. Click on the browse button in
the field and select a file. If you select None, no
filter file is used (testing in temperature chamber
is not considered).

NOTE. Filter file selection is available only in the
User Defined mode.

Filter File 2 (for testing in Temperature Chamber
with Differential Probing) 

Select the filter file to use with differential
probing for temperature chamber testing. Click
on the browse button in the field and select a
file. If you select None, no filter file is used
(testing in temperature chamber is not
considered).

NOTE. Filter file selection is available only in the
User Defined mode.

Save Report As Type Value "Web Archive (*.mht;*.mhtml, *html, *xls)"
Disable Single Lane Pop-up Value "True/False" (If "true" is selected, it

disables the first lane popup and If "false" is
selected, popup appears "Please connect lane"
when the test execution is started)

Bandwidth Limit the Data Channels to (GHz) Select the BW limit if the data channel in GHz.
Default it is set to 8 GHz.

Bandwidth Limit the DClock Channels to (GHz) Select the BW limit if the Clock channel in GHz.
Default it is set to 8 GHz.

NOTE. If you change the channel selection for Data+ (DP), Data– (DN), Clock+
(CP), and Clock– (CN) signals, make sure that you change the trigger source
correspondingly in the Analyze tab for each of the measurements. If you do not
do this, the waveform might not trigger and the measurements might not be
completed.
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For temperature chamber testing, a filter file with S4 parameters is used to
compensate the factors introduced due to length of the probe cable when testing
the DUT in temperature chamber. You will need one or two filter files based on
the selected clock probing. If you select Single-ended probing, you must specify
only one filter file (Filter File 1). The application ignores the Filter File 2 even if
you provide it. If you select Differential probing, then you must specify both the
filter files (Filter File 1 and Filter File 2).

The following table lists the tabs and button controls for the tests:

Table 5: Configure panel buttons

Configure
parameters

Description

Acquire Shows the various parameters related to acquisition of a selected test.
Analyze Shows the various parameters related to analysis of a selected test. These

parameters can vary from one test to another test. For example, Vertical
scale, Vertical offset, Horizontal scale, and others.

Limits Applies to a specific version. It shows the measurement lower and upper limits
using different types of comparisons like EQ(==), NE(!=), GT(>), LT(<),
GE(>=), LE(<=), GTLT(> <), GELT(>= <), GTLE(> <=), LTGT(< >), LEGE(<=
>=), LEGT(<= >), LTGE(< G=), GELE(>= <=). Some use unary operands and
some use binary operands. For unary operands, only value1 (on the left) is
active.

Comments Specify a comment up to 256 characters long for selected test.
Restore Restores the default values.
Save Saves and applies the configuration parameters that you have set.
Cancel Dismisses the dialog box.
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Configure Acquire panel

Configure Limits panel
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Configure Analyze panel

Click Run in the Select panel to run the selected tests.

Refer to the following table for various test limit comparisons:

Table 6: Test limit comparisons

Comparison string Description
EQ(==) Equal to
NE(!=) Not equal to
GT(>) Greater than
LT(<) Less than
GE(>=) Greater than or Equal to
LE(<=) Less than or Equal to
GTLT(><) Greater than and Less than
GELT(>=<) Greater than or equal to and Less than
GTLE(><=) Greater than and Less or equal to
LTGT(<>) Less than and Greater than
LEGE(<= >=) Less than or equal to and Greater than or equal

to
LEGT(<= >) Less than or equal to and Greater than
LTGE(< >=) Less than and Greater than or equal to
GELE(>= =<) Greater than or equal to and Less than or equal

to
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You have the following options:

■ Restore compliance mode values.

■ Change the parameters associated with analysis configuration.

■ Change the test limits in the User Defined mode.

■ Add comments for the selected test that would appear in the Report panel.

Typical configuration parameters
The following table shows the typical or default configuration parameters for
single-ended and differential tests in the clock normal and clock continuous
modes.

Acquire parameters Single-ended tests
(Clock Mode Normal)

Single-ended tests
(Clock Mode
Continuous)

Differential tests (Clock
Mode Normal)

Differential tests (Clock
Mode Continuous)

Data lane
tests

Clock lane
tests

Data lane
tests

Clock lane
tests

Data lane
tests

Clock lane
tests

Data lane
tests

Clock lane
tests

Vertical Scale (mV) 200 200 200 200 200 200 200 200
Vertical Position for
Data (div)

–2.6 NA –2.6 NA –2.6 NA –2.6 NA

Vertical Position for
Clock (div)

NA –2.6 NA –2.6 NA 2.6 NA 2.6

Vertical Position (div) –2.6 –2.6 –2.6 –2.6 2.6 2.6 2.6 2.6
Vertical Offset (V) 0 0 0 0 0 0 0 0
Horizontal Scale (us) 8 8 8 8 8 8 8 8
Sample Rate (GS/s) 12.5 12.5 12.5 12.5 12.5 12.5 12.5 12.5
Record Length 1000000 1000000 1000000 1000000 1000000 1000000 1000000 1000000
Analyze parameters
Trigger Type Transition Transition Transition Edge Transition Transition Transition Edge
Trigger Source Ch1 Ch3 Ch1 Ch3 Ch1 Ch3 Ch1 Ch3
Trigger Upper
Level (V)

1 1 1 NA 1 1 1 NA

Trigger Lower
Level (V)

0.05 0.05 0.05 0.05 0.05 0.05 0.05 0.05

Trigger Level for
Continuous Clock
Mode (V)

NA NA NA 0.2 NA NA 0.2 0.2

Trigger Time (ps) 500 500 500 500 500 500 500 500
Trigger Transition Greater

Than
Greater
Than

Greater
Than

NA Greater
Than

Greater
Than

Greater
Than

NA
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Acquire parameters Single-ended tests
(Clock Mode Normal)

Single-ended tests
(Clock Mode
Continuous)

Differential tests (Clock
Mode Normal)

Differential tests (Clock
Mode Continuous)

Data lane
tests

Clock lane
tests

Data lane
tests

Clock lane
tests

Data lane
tests

Clock lane
tests

Data lane
tests

Clock lane
tests

Trigger Slope Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Trigger If Violation Occurs Occurs Occurs NA Occurs Occurs Occurs NA

View and select connected instruments

Viewing connected
instruments

The Tools > Instrument Bench menu item is used to discover connected
instruments required for the tests. The application uses TekVISA to discover the
connected instruments. Once the operation is done, the Instrument Bench dialog
box resumes operation and lists the instrument-related details based on the
selected search criteria.

NOTE. When the TekVISA Instrument Manager checks for connected Instruments,
the Instrument Bench dialog box does not respond.

For example, if you select LAN and GPIB as the search criteria in the Instrument
Bench dialog box and click Refresh, the TekVISA Instrument Manager checks
for the availability of instruments over LAN and the details of the instruments are
displayed under Retrieved Instruments table.
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Provide the time in the TekVISA Refresh Timeout (Seconds) field, within which
if the TekVISA Instrument Manager does not find the instruments, the
TekExpress application resumes the operation. If you choose Non-VISA
resources, all the instruments supported by TekExpress but not communicating
over the VISA layer can be searched.

Selecting connected
instruments

View the instruments connected in the Configuration panel. The upper half of the
panel displays the general parameters for the tests under the selected test suite.
Select the Real Time Scope to connect to from the drop-down list.

 

 

NOTE. The list of instruments displayed is specific to the selected test suite. It
does not show all the connected instruments.
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Acquire live waveform for analysis
Select the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources. When you click Run, by default the
application acquires live signals from the source.

Click the Acquire tab to see acquisition parameters, and acquisition status of the
selected test suite. The Acquire panel is specific to a suite and gets updated every
time the selected test suite is changed. This panel shows the acquisition details
for the tests in the currently selected suite. The tests with common acquisition
parameters are grouped together and shown as a single acquisition.
 

 

This example shows the acquire panel with channel selections.
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Table 7: Controls on the Acquire panel

Selection Function
Data Source Lists the sources assigned for each data line (Dp and Dn). Select the

source (channel) for each data line (Dp and Dn). Once you select a
channel for Dp, you cannot select the same channel for other lines (Dn,
Clkp, and Clkn) and vice versa).

Clock Source Lists the sources assigned for each clock line (Clkp and Clkn). Select the
source (channel) for each clock line (Dp and Dn). Once you select a
channel for Clkp, you cannot select the same channel for other lines (Dn,
Dn, and Clkn) and vice versa).
If you have selected Differential Clock Lane Probing in the Select panel,
only one source selection is displayed (differential probe clock needs only
one channel as source).

Column Name
Test Displays the name of the selected test for performing acquisitions. One or

more tests can perform the same acquisitions.
Status Acquisition status of the running test at intervals. The messages are

passed only in live acquisition.
Acquisition Updates the location of the acquisition name.
Acquire Options
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Selection Function
Use Pre-recorded
Waveform Files

When enabled, uses pre-recorded waveforms for the selected test.

Acquire Step By Step When enabled, displays the reference input waveform of the selected
test. This helps you to compare the input waveform with the reference
waveform, allows you to change the setup before acquiring the
waveforms, and then proceeds with the next selected test.

Use prerecorded waveforms for analysis
Select the Acquire tab to see unique acquisitions, acquisition parameters,
acquisition status, and prerecorded waveform files of the selected test suite. The
Acquire panel is specific to a group and gets updated every time the selected test
group is changed. This panel shows the acquisition details for the tests in the
currently selected group. The tests with the common acquisition parameters are
grouped together and shown as a single acquisition.

For pre-recorded testing, it is recommended that you capture the waveforms at
12.5 Gs/s sample rate. However, if you capture the waveforms at a different
sample rate, ensure that you change the Sample Rate parameter in the Configure
Panel appropriately for each of the selected tests.

NOTE. You can only use saved sessions in which the tests have been run in
Automatic mode for prerecorded testing. You cannot use the sessions in which
tests have been run in Manual mode for prerecorded testing.

NOTE. You cannot use the prerecorded waveform option for the 1.5.3 HS Clock
Rising Edge Alignment to First Payload Bit test.
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Column name Function
Test Name Name of the tests performing acquisitions. One

or more tests can perform the same
acquisitions.

Acquisition Test acquisition status of the running test
passed at intervals.

Waveform File Prerecorded waveform files of unique
acquisitions. You can select waveform files by
clicking the hyperlink. This allows you to select
any waveform file using the standard file open
window.

NOTE. To use the prerecorded option, it is recommended that you use a waveform
file (.wfm) which has been captured from a Tektronix oscilloscope. This
eliminates the need to use an oscilloscope. You can manually select waveforms
and perform the tests with a click of the Run button.

The following Acquire source options are available:

■ Use Pre-recorded Waveform Files: Enabling or disabling the option shows
or hides the waveform file column in the acquisition table.

Follow these steps to save a session and use the pre-recorded mode to run it:

1. Open a new session.

2. Select the tests.
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3. Highlight a test and click Configure. Change the sample rate parameter to
the desired value for each of the selected tests.

4. Save the session.

5. In the Acquire panel, select Use Pre-recorded Waveform Files and then
select the waveforms for each of the tests. Make sure that the waveform
names have a suffix DP, DN, CP, and CN indicating the data and clock
waveforms. For example.....

■ Acquire Step by Step: Selecting this prompts you at the end of each
acquisition before proceeding to the next one.

■ Show Acquire Parameters: Selecting this shows the acquisition parameters.

When you select “Use Pre-recorded”, the first column shows the Acquisition, the
second column shows the Test, and the next column shows the Waveform File
for analysis.

View the progress of analysis
Click the Analyze tab to view the progress of the analysis. As the analysis of each
test is complete, the result value is updated.
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Analyze Table The Analyze table contains the following:

■ The test name.
■ The status of the tests that are being run.
■ The low and high limit values, and margins, for the tests.
■ The measured values for the tests.
■ The pass/fail status of the tests.

The tests that are not yet started are shown with a “To be Started” status. A
summarized status of the currently running test is shown in the Status Messages
panel.

The Status Messages window time-stamps all run time messages and displays
them. You can do the following:

■ Display Status: Enable/Disable status messages.
■ Auto Scroll: Scroll the status messages automatically.
■ Clear All: Clear all status messages in Status Window.
■ Save Status: Save all status messages in text file. Displays a standard save

file window and saves the status messages in the user specified file.

View the report
After the analysis, a report is automatically generated and displayed in the report
panel. The device information such as oscilloscope model, serial number,
firmware version of the oscilloscope, version information of the TekExpress and
the application, start time, and the execution time are displayed.

A table shows the test name, measurement details, test result (pass/fail),
compliance mode, and analysis time. Save the report as an MHT file using the
File > Save Report As option. 

NOTE. If you use a secondary monitor, verify that the screen resolution of the
secondary monitor is the same as that of the primary display. This ensures that
captured images in the reports are of the same size.
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View test related files
All the test related files for currently selected tests are always saved under: My
Documents\My TekExpress\D-PHY\SessionName.

Case 1. An example image of data when the session is still not saved and is in the
My TekExpress/D–PHY path as “Untitled Session”, the DUT ID is set to
DUT001, and the tests are performed twice (two folders are created with the file
naming convention YYYYMMDD_HHMMSS (Date_Time).
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Case 2. An example image of data when the session is still not saved and is in the
My TekExpress/D-PHY path as “Untitled Session”, the DUT001 folder already
present (tests are performed twice), and the DUT ID is now set to DUT002 (here
the tests are performed once).
 

 

Case 3. An example image of data when the session is saved and is in the My
TekExpress/D-PHY path as “Test”.
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Application examples

Connection setup

You need the following equipment (see Compatibility):
■ A supported Tektronix DPO oscilloscope
■ Single-ended probe
■ Differential probe
■ Device under test
■ Probing board
■ For multilane testing, RF switch:
Make connections as follows for single-ended tests:
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Make connections as follows for differential tests:
 

 

Make connections as follows when you are using an RF switch and probing
board:
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Configuring parameter values
To configure a test, do the following:
1. In the Select panel click Configure.
2. In the Configure panel, set the following general parameters that are common

for all tests:

Parameter Value
Real Time Scope Select the oscilloscope to which to connect.
Measurement Method Select the measurement method: Automatic

or Manual.

NOTE. The Manual method is available only
when in the User Defined mode.

Filter File 1 (for testing in temperature
chamber)

Select the filter file to use for temperature
chamber testing. Click on the browse button
in the field and select a file. If you select
None, no filter file is used (testing in
temperature chamber is not considered).

NOTE. Filter file selection is available only in
the User Defined mode.

Filter File 2 (for testing in temperature
chamber with Differential Probing)

Select the filter file to use with differential
probing for temperature chamber testing.
Click on the browse button in the field and
select a file. If you select None, no filter file is
used (testing in temperature chamber is not
considered).

NOTE. Filter file selection is available only in
the User Defined mode.

The Automatic measurement method mode, lets you perform a test without
any intervention. You must select one or more tests, configure the tests (or
use the default values) and click Run to perform the test. The application
acquires and analyzes the data, and displays a report when complete.

If you select the Manual mode, select one or more tests, configure the tests
(or use the default values) and click Run to perform the test. The application
begins to acquire data. A window opens where you are prompted to place the
cursors on the acquired waveform and click OK. Go to the TekScope
application and zoom the waveform around the trigger point. Place the
cursors on the waveform to capture the values at those points and click OK
in the window. The application completes the test and displays the report.

For temperature chamber testing, a filter file with S4 parameters is used to
compensate the factors introduced due to length of the probe cable when
testing the DUT in temperature chamber. You will need one or two filter files
based on the selected clock probing. If you select Single-ended probing, you
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must specify only one filter file (Filter File 1). The application ignores the
Filter File 2 even if you provide it. If you select Differential probing, then
you must specify both the filter files (Filter File 1 and Filter File 2).

NOTE. Other applications will display there windows in the background. The
TekScope application takes precedence over other applications. Use Alt+Tab
to view the other application windows.

3. Select either Compliance Mode or User Defined Mode. In the User Defined
Mode, you can modify the test parameters but you will no longer be testing
against the compliance standards.

Temperature chamber testing
The TekExpress D-PHY offers the temperature chamber testing which is done at
system level when the device is put in the oven and the connection points from
the DUT are extended to the probe using a wire. This wire is 60” (5 ft) long and
the signal must be de-embedded for the measurement. Filter files are needed to
offset the cable effects that are introduced in temperature chamber testing.

The setup shown below is expected to be done by the user. The DUT is ideally
placed in an environment in which the temperature can be externally controlled,
which we call the Temperature Oven. The DUT is then connected to the setup
using the above-mentioned long cables that come from within the oven to the
Tektronix P7500 series probes that are then connected to the desired channels of
the Tektronix real time scope.

However, the P7500 probe does not support LP measurement but can support all
measurements in normal mode. All the measurements that can be performed
using the LP-HS transition mode are supported in Temperature chamber mode.

The next specifies how to control this testing through the application once the
setup is ready.
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Steps for performing
temperature chamber

testing

The application provides a set of filter files. However, you have the option of
selecting your own set of filter files.

Temperature chamber testing is available only in the User Defined mode.

1. Select the test and click Configure.
2. Select the User Defined mode.
3. Select Filter File1 by browsing to the folder.
4. Select Filter File 2 to use with differential probing for temperature chamber

testing by browsing to the folder.

You will need one or two filter files based on the selected clock probing. If you
select Single-ended probing, you must specify only one filter file (Filter File 1).
If you select Differential probing, then you must specify both the filter files
(Filter File 1 and Filter File 2).

The filter file for each of the combinations is listed in the table
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Table 8: Filter file names

Selection Affected channels/Lanes File name
NORMAL CLOCK, SINGLE
ENDED

Dp, Dn, Cp,Cn Single ended filter for all lanes

NORMAL CLOCK,
DIFFERENTIAL

Dp, Dn, Cp-n Single ended for Data lane,
Differential filter for clock lane

CONTINUOUS CLOCK,
SINGLE ENDED

Dp, Dn, Cp, Cn Single ended filter for all lanes

CONTINUOUS CLOCK,
DIFFERENTIAL

Dp, Dn, Cp-n Single ended for Data lane,
Differential filter for clock lane

Logic flow of temperature
chamber testing in
TekExpress D-PHY
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Multilane testing with RF switch
Multilane testing with an RF switch takes measurements on four lanes. The
system can automatically receive signals from all four lanes without user
intervention, save the acquisitions, and then take measurements on one lane, and
then the signals from next lane are automatically selected and the measurements
are performed.

Without automation you can select which lane (s) to test, and based on the
selection, the application acquires the desired signals and takes the selected
measurements on those acquired waveforms. When done with a lane, the
software prompts you to change the connection over to the next lane.

After each acquisition the waveforms are saved, with proper naming convention
for specific lanes, analyzed, and the results for each lane updated in the analyze
panel and the report panel.

Table 9: Required Equipment

Item Description
RF switch Keithley S46 series Microwave Switch System
Reference Termination Board
(otpional)

D-PHY Reference Termination Board (RTB) available from
University of New Hampshire (UNH-IOL). This UNH RTB
is orderable from, http://www.iol.unh.edu/services/testing/
mipi/MIPI_Test_Fixture_Order_Form.doc

GPIB cable A GPIB cable is required when using an RF switch for
multi-lane automation.

Setting up Multilane
Testing

Click here for information on connections for multilane testing. Perform the
following steps to set up the equipment for multilane testing:

1. Connect a GPIB cable between the oscilloscope and the RF switch.
2. Connect the input channels of the oscilloscope to the outputs of the Probing

board.
3. Connect the inputs of the Probing board to the outputs of the RF switch.
4. Connect the Dp signals form each lane of the DUT to the inputs of channel

1 of the RF switch.
5. Connect the Dn signals from each lane of the DUT to the corresponding

inputs of channel 2 of the RF switch.
6. Connect the Cp signal to the input of channel 3 of the RF switch. The clock

lane is connected through the RF switch to ensure that there is no skew
between the data and clock signals.

7. Connect the Cn signal to the input of channel 4 of the RF switch.
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8. In the Select tab, select the Automate Lane switching with RF switch check
box

9. In the Acquire tab, select Acquire Live Waveforms.
10. Select RF Switch setup.
11. Map the lanes and input types to the location on the RF switch.

 

 

Group 1 tests

Testing data lane LP-TX
thevenin output high level

voltage (VOH)

Connections for data lane LP-TX thevenin output high level voltage (VOH). Click
here for information on connections for the Data Lane LP-TX Thevenin Output
High Level Voltage (VOH) test.
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Configure and run data lane LP-TX thevenin output high level voltage (VOH).

1. In the Select panel, select the Device.

NOTE. The Data Lane LP-TX Thevenin Output High Level Voltage (VOH)
test is not available when the selected clock lane probing is Differential.

You can also perform Data Lane LP related measurements on a signal that
has an LP-HS transition.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
(Data Lanes Acquisition in Escape Mode with Data as Trigger). The
following table lists the compliance mode values and the permitted range of
values for the user-defined mode:

Table 10: Configuration parameters for Data Lane LP-TX Thevenin Output High
Level Voltage (VOH)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 11: Analysis parameters for Data Lane LP-TX Thevenin Output High Level
Voltage (VOH)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
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Parameter Default User defined mode
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

8. Click Limits to view and change the Data Lane LP-TX Thevenin Output
High Voltage DP and Data Lane LP-TX Thevenin Output High Voltage DN
values, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to accept the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane LP-TX
thevenin output low level

voltage (VOL)

Connections for data lane LP-TX thevenin output low level voltage (VOL). Click
here for information on connections for the Data Lane LP-TX Thevenin Output
Low Level Voltage (VOL) test.
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Configure and run data lane LP-TX thevenin output low level voltage (VOL).

1. In the Select panel, select the Device.

NOTE. The Data Lane LP-TX Thevenin Output Low Level Voltage (VOL) test
is not available when the selected clock lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Data Lanes Acquisition in Escape Mode with Data as Trigger. The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 12: Configuration parameters for Data Lane LP-TX Thevenin Output Low
Level Voltage (VOL)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 13: Analysis parameters for Data Lane LP-TX Thevenin Output Low Level
Voltage (VOL)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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8. Click Limits to view and change the Data Lane LP-TX Thevenin Output
Low Voltage DP and Data Lane LP-TX Thevenin Output Low Voltage DN
values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane rise time Connections for data lane rise time. Click here for information on connections for
the Data Lane Rise Time test.
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Configure and run data lane rise time.

1. In the Select panel, select the Device.

NOTE. The Data Lane Rise Time test is not available when the selected clock
lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Data Lanes Acquisition in Escape Mode with Data as Trigger. The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 14: Configuration parameters for Data Lane Rise Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 15: Analysis parameters for Data Lane Rise Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Data Lane Rise Time DP and Data Lane
Rise Time DN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane fall time Connections for data lane fall time. Click here for information on connections for
the Data Lane Fall Time test.
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Configure and run data lane fall time.

1. In the Select panel, select the Device.

NOTE. The Data Lane Fall Time test is not available when the selected clock
lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Data Lanes Acquisition in Escape Mode with Data as Trigger. The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 16: Configuration parameters for Data Lane Fall Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 17: Analysis parameters for Data Lane Fall Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Data Lane Fall Time DP and Data Lane
Fall Time DN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane slew rate
versus CLOAD

Connections for data lane LP-TX slew rate versus CLOAD (V-tSR). Click here for
information on connections for the Data Lane LP-TX Slew Rate Versus CLOAD
(ōVō/tSR) test.

Application examples  

58  TekExpress D-PHY Printable Application Help



Configure and run data lane LP-TX slew rate versus CLOAD (V-tSR).

1. In the Select panel, select the Device.

NOTE. The Data Lane Fall Time test is not available when the selected clock
lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Data Lanes Acquisition in Escape Mode with Data as Trigger. The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 18: Configuration parameters for Data Lane Fall Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 19: Analysis parameters for Data Lane Fall Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Data Lane Fall Time DP and Data Lane
Fall Time DN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane pulse
width of Exclusive-OR

clock

Connections for data lane LP-TX pulse width of Exclusive-OR clock. Click here for
information on connections for the Data Lane LP-TX Pulse Width of Exclusive-
OR Clock test.
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Configure and run data lane LP-TX pulse width of Exclusive-OR clock.

1. In the Select panel, select the Device.

NOTE. The Data Lane Fall Time test is not available when the selected clock
lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Data Lanes Acquisition in Escape Mode with Data as Trigger. The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 20: Configuration parameters for Data Lane Fall Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 21: Analysis parameters for Data Lane Fall Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Data Lane Fall Time DP and Data Lane
Fall Time DN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane LP-TX
period of Exclusive-OR

clock

Connections for data lane LP-TX period of Exclusive-OR clock. Click here for
information on connections for the Data Lane LP-TX Period of Exclusive-OR
Clock test.

Application examples  

62  TekExpress D-PHY Printable Application Help



Configure and run data lane LP-TX period of Exclusive-OR clock.

1. In the Select panel, select the Device.

NOTE. The Data Lane Fall Time test is not available when the selected clock
lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Data Lanes Acquisition in Escape Mode with Data as Trigger. The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 22: Configuration parameters for Data Lane Fall Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 23: Analysis parameters for Data Lane Fall Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Data Lane Fall Time DP and Data Lane
Fall Time DN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

View report for
Group 1 tests

The application automatically displays a report in the Report panel once the test
is successfully completed. A table shows the test name, measurement details, test
result (pass/fail), compliance mode, and analysis time. Save the report as an
MHT file using the File > Save Report As option. The following screen shows
the results for Group 1 tests.
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Group 2 tests

Testing clock lane LP-TX
thevenin output high level

voltage (VOH)

Connections for clock lane LP-TX thevenin output high level voltage (VOH). Click
here for information on connections for the Clock Lane LP-TX Thevenin Output
High Level Voltage (VOH) test.
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Configure and run clock lane LP-TX thevenin output high level voltage (VOH).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane LP-TX Thevenin Output High Level Voltage (VOH)
test is not available when the selected clock lane probing is Differential.

You can also perform Clock LP mode measurements using LP-HS transition.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Clock Lanes Acquisition in Escape Mode with Clock as Trigger. The
following table lists the compliance mode values and the permitted range of
values for the user-defined mode:

Table 24: Configuration parameters for Clock Lane LP-TX Thevenin Output High
Level Voltage (VOH)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 25: Analysis parameters for Clock Lane LP-TX Thevenin Output High
Level Voltage (VOH)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0,05, 0.1 

Trigger Time (pS) 500 250, 500 
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Parameter Default User defined mode
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Clock Lane LP-TX Thevenin Output
High Voltage CP and Clock Lane LP-TX Thevenin Output High Voltage CN
values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane LP-TX
thevenin output low level

voltage (VOL)

Connections for clock lane LP-TX thevenin output low level voltage (VOL). Click
here for information on connections for the Clock Lane LP-TX Thevenin Output
Low Level Voltage (VOL) test.

 Application examples

TekExpress D-PHY Printable Application Help 67



Configure and run clock lane LP-TX thevenin output low level voltage (VOL).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL) test
is not available when the selected clock lane probing is Differential.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Clock Lanes Acquisition in Escape Mode with Clock as Trigger. The
following table lists the compliance mode values and the permitted range of
values for the user-defined mode:

Table 26: Configuration parameters for Clock Lane LP-TX Thevenin Output Low
Level Voltage (VOL)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 27: Analysis parameters for Clock Lane LP-TX Thevenin Output Low
Level Voltage (VOL)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
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Parameter Default User defined mode
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Clock Lane LP-TX Thevenin Output
Low Voltage CP and Clock Lane LP-TX Thevenin Output Low Voltage CN
values, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane rise
time

Connections for clock lane rise time. Click here for information on connections for
the Clock Lane Rise Time test.
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Configure and run clock lane rise time.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane Rise Time test is not available when the selected clock
lane probing is Differential.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Clock Lanes Acquisition in Escape Mode with Clock as Trigger. The
following table lists the compliance mode values and the permitted range of
values for the user-defined mode:

Table 28: Configuration parameters for Clock Lane Rise Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 29: Analysis parameters for Clock Lane Rise Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Clock Lane Rise Time CP and Clock
Lane Rise Time CN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. In the Select panel, click Run to start the test. The Acquire panel shows the
progress and status of the test as it runs.

Testing clock lane fall time Connections for clock lane fall time. Click here for information on connections for
the Clock Lane Rise Time test.
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Configure and run clock lane fall time.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane Fall Time test is not available when the selected clock
lane probing is Differential.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Clock Lanes Acquisition in Escape Mode with Clock as Trigger. The
following table lists the compliance mode values and the permitted range of
values for the user-defined mode:

Table 30: Configuration parameters for Clock Lane Fall Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 31: Analysis parameters for Clock Lane Fall Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Clock Lane Fall Time CP and Clock
Lane Fall Time CN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane LP-TX
slew rate versus CLOAD

(V-tSR)

Connections for clock lane LP-TX slew rate versus CLOAD (V-tSR). Click here for
information on connections for the Clock Lane LP-TX Slew Rate Versus
CLOAD test.
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Configure and run clock lane LP-TX slew rate versus CLOAD (V-tSR).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane Fall Time test is not available when the selected clock
lane probing is Differential.

4. Select the Test Mode as Escape.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type
Clock Lanes Acquisition in Escape Mode with Clock as Trigger. The
following table lists the compliance mode values and the permitted range of
values for the user-defined mode:

Table 32: Configuration parameters for Clock Lane Fall Time

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 33: Analysis parameters for Clock Lane Fall Time

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Clock Lane Fall Time CP and Clock
Lane Fall Time CN values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

View report for
Group 2 tests

The application automatically displays a report in the Report panel once the test
is successfully completed. A table shows the test name, measurement details, test
result (pass/fail), compliance mode, and analysis time. Save the report as an
MHT file using the File > Save Report As option. The following screen shows
the results for Group 2 tests.
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Group 3 tests

Testing data lane HS
entry: Data lane TLPX

value

Connections for data lane HS entry: Data lane TLPX value. Click here for
information on connections for the Data Lane HS Entry: Data Lane TLPX Value
test.
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Configure and run data lane HS entry: Data lane TLPX value. The Data Lane HS
Entry: Data Lane TLPX Value test is supported on LP-HS waveforms although it
is not recommended to use LP-HS waveforms for this test.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

NOTE. The Clock mode Continuous is available only when the test mode is
Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Data Lane HS Entry: Data Lane TLPX Value test is not available
when the selected clock lane probing is Differential.

4. Select the Test Mode as Escape or Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 34: Configuration parameters for Data Lane HS Entry: Data Lane TLPX
Value

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)

–2.6 +3 to –3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 35: Analysis parameters for Data Lane HS Entry: Data Lane TLPX Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
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Parameter Default User defined mode
Trigger Lower Level V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane HS Entry DATA Lane TLP
value and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS
entry: THS-PREPARE

value

Connections for data lane HS entry: THS-PREPARE value. Click here for
information on connections for the Data Lane HS Entry: THS-PREPARE Value
test.
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Configure and run data lane HS entry: THS-PREPARE value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 36: Configuration parameters for Data Lane HS Entry: THS-PREPARE
Value

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
–3 to +3 
+3 to –3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 37: Analysis parameters for Data Lane HS Entry: THS-PREPARE Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Data Lane HS Entry: THS-PREPARE
values in ns, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS
entry: THS-PREPARE +

THS-ZERO value

Connections for data lane HS entry: THS-PREPARE + THS-ZERO value. Click here
for information on connections for the Data Lane HS Entry: THS-PREPARE +
THS-ZERO Value test.
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Configure and run data lane HS entry: THS-PREPARE + THS-ZERO value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 38: Configuration parameters for Data Lane HS Entry: THS-PREPARE +
THS-ZERO

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
–3 to +3 
–3 to –3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 39: Analysis parameters for Data Lane HS Entry: THS-PREPARE + THS-
ZERO

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane HS Entry: THS-PREPARE +
THS-ZERO values in ns, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS-TX
differential voltages

(VOD(0), VOD(1))

Connections for data lane HS-TX differential voltages (VOD(0), VOD(1)). Click here
for information on connections for the Data Lane HS-TX Differential Voltages
(VOD(0), VOD(1)) Value test.
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Configure and run data lane HS-TX differential voltages (VOD(0), VOD(1)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 40: Configuration parameters for Data Lane HS-TX Differential Voltages
(VOD(0), VOD(1))

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 41: Analysis parameters for Data Lane HS-TX Differential Voltages
(VOD(0), VOD(1))

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the VOD(1) and VOD(0) values in mV, and
the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS-TX
differential voltage

mismatch (VOD)

Connections for data lane HS-TX differential voltage mismatch (VOD). Click here
for information on connections for the Data Lane HS-TX Differential Voltage
Mismatch (VOD) Value test.

Application examples  

84  TekExpress D-PHY Printable Application Help



Configure and run data lane HS-TX differential voltage mismatch (VOD).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 42: Configuration parameters for Data Lane HS-TX Differential Voltage
Mismatch (VOD)

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
+2.6 

 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 43: Analysis parameters for Data Lane HS-TX Differential Voltage
Mismatch (VOD)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the VOD values in mV, and the compare
string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS-TX
Single-Ended output high

voltages (VOHHS(DP),
VOHHS(DN))

Connections for data lane HS-TX Single-Ended output high voltages (VOHHS(DP),
VOHHS(DN)). Click here for information on connections for the Data Lane HS-TX
Single-Ended Output High Voltages ((VOHHS(DP), VOHHS(DN)) test.
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Configure and run data lane HS-TX Single-Ended output high voltages (VOHHS(DP),
VOHHS(DN)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 44: Configuration parameters for Data Lane HS-TX Single-Ended Output
High Voltages (VOHHS(DP), VOHHS(DN))

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)

–2.6 +3 to –3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 45: Analysis parameters for Data Lane HS-TX Single-Ended Output High
Voltages (VOHHS(DP), VOHHS(DN))

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Polarity Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Data Lane HS-TX Single-Ended Output
High Voltages DP and DN values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS-TX
static Common-Mode
voltages (VCMTX(1),

VCMTX(0))

Connections for data lane HS-TX static Common-Mode voltages (VCMTX(1),
VCMTX(0)). Click here for information on connections for the Data Lane HS-TX
Static Common-Mode Voltages (VCMTX(1), VCMTX(0)) test.
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Configure and run data lane HS-TX static Common-Mode voltages (VCMTX(1),
VCMTX(0)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 46: Configuration parameters for Data Lane HS-TX Static Common-Mode
Voltages (VCMTX(1), VCMTX(0))

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 47: Analysis parameters for Data Lane HS-TX Static Common-Mode
Voltages (VCMTX(1), VCMTX(0))

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Common Mode Voltages VTX(0) and
VTX(1) values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS-TX
static Common-Mode

voltage mismatch
(VCMTX(1,0))

Connections for data lane HS-TX static Common-Mode voltage mismatch
(VCMTX(1,0)). Click here for information on connections for the Data Lane HS-
TX Static Common-Mode Voltage Mismatch (VCMTX(1,0)) test
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Configure and run data lane HS-TX static Common-Mode voltage mismatch
(VCMTX(1,0)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 48: Configuration parameters for Data Lane HS-TX Static Common-Mode
Voltage Mismatch (VCMTX(1,0))

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 49: Analysis parameters for Data Lane HS-TX Static Common-Mode
Voltage Mismatch (VCMTX(1,0))

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

 Application examples

TekExpress D-PHY Printable Application Help 91



Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Common Mode Voltage Mismatch
values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS-TX
dynamic Common-Level

variations between
50-450 MHz (VCMTX(LF))

Connections for data lane HS-TX dynamic Common-Level variations between
50-450 MHz (VCMTX(LF)). Click here for information on connections for the Data
Lane HS-TX Dynamic Common-Level Variations Between 50-450 MHz
(VCMTX(LF)) test
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Configure and run data lane HS-TX dynamic Common-Level variations between
50-450 MHz (VCMTX(LF)). The Data Lane HS-TX Dynamic Common-Level
Variations Between 50-450 MHz (VCMTX(LF)) test uses a band pass filter. To
perform the measurement, the application uses both the original waveform
(unfiltered) and the filtered waveform as follows: 

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical
waveform names are like Acq1_Data Lanes Acquisition with Data As
Trigger and BandPass Filter_Lane1_DN.wfmand Acq1_Data Lanes
Acquisition with Data As Trigger and BandPass Filter_Lane1_DP.wfm.

2. Applies a band pass filter on live channels and stores them on the Math
channel. Typical filtered waveform file name are like
Lane1_FilteredTwoChannelwithDataasTriggerAndBandPassFilter_DN.WFM
and
Lane1_FilteredTwoChannelwithDataasTriggerAndBandPassFilter_DP.WFM
.

3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms.
However, make sure that the filtered waveforms are in the same folder as the
unfiltered waveforms for these measurements to run correctly in pre-recorded
mode. The filtered waveforms for the measurements must be the ones saved by
the TekExpress application. The measurements will not work as expected if any
other filtered waveforms are used.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
Lanes Acquisition with Data as Trigger and BandPass Filter). The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 50: Configuration parameters for Data Lane HS-TX Dynamic Common-
Level Variations Between 50-450 MHz (VCMTX(LF))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position for Data (div) –2.6 +3 to –3 
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Parameter Default User defined mode
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 51: Analysis parameters for Data Lane HS-TX Dynamic Common-Level
Variations Between 50-450 MHz (VCMTX(LF))

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane HS-TX Dynamic Common-
Level Variations value in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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Testing data lane HS-TX
dynamic Common-Level

variations above 450 MHz
(VCMTX(HF))

Connections for data lane HS-TX dynamic Common-Level variations above 450 MHz
(VCMTX(HF)). Click here for information on connections for the Data Lane HS-TX
Dynamic Common-Level Variations Above 450 MHz (VCMTX(HF)) test
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Configure and run data lane HS-TX dynamic Common-Level variations above
450 MHz (VCMTX(HF)). The Data Lane HS-TX Dynamic Common-Level
Variations Above 450 MHz (VCMTX(LF)) test uses a high pass filter. To
perform the measurement, the application uses both the original waveform
(unfiltered) and the filtered waveform as follows:

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical
waveform names are like Acq2_Data Lanes Acquisition with Data As
Trigger and HighPass Filter_Lane1_DN.wfmand Acq2_Data Lanes
Acquisition with Data As Trigger and HighPass Filter_Lane1_DP.wfm.

2. Applies a high pass filter on live channels and stores them on the Math
channel. Typical filtered waveform file names are like
Lane1_FilteredTwoChannelwithDataasTriggerAndHighPassFilter_DN.WFM
and
Lane1_FilteredTwoChannelwithDataasTriggerAndHighPassFilter_DP.WFM.

3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms.
However, make sure that the filtered waveforms are in the same folder as the
unfiltered waveforms for these measurements to run correctly in pre-recorded
mode. The filtered waveforms for the measurements must be the ones saved by
the TekExpress application. The measurements will not work as expected if any
other filtered waveforms are used. .

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
Lanes Acquisition with Data as Trigger and HighPass Filter). The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:

Table 52: Configuration parameters for Data Lane HS-TX Dynamic Common-
Level Variations Above 450 MHz (VCMTX(HF))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position for Data (div) –2.6 +3 to –3 
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Parameter Default User defined mode
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 53: Analysis parameters for Data Lane HS-TX Dynamic Common-Level
Variations Above 450 MHz (VCMTX(HF))

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane HS-TX Dynamic Common-
Level Variations value in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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Testing data lane HS-TX
20%-80% rise time (tR)

Connections for data lane HS-TX 20%-80% rise time (tR). Click here for information
on connections for the Data Lane HS-TX 20%-80% Rise time (tR) test.
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Configure and run data lane HS-TX 20%-80% rise time (tR).
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.
4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 54: Configuration parameters for Data Lane HS-TX 20%-80% Rise time
(tR)

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 55: Analysis parameters for Data Lane HS-TX 20%-80% Rise time (tR)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the tR value in pS, and the compare string.
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9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS-TX
80%-20% fall time (tF)

Connections for data lane HS-TX 80%-20% fall time (tF). Click here for information
on connections for the Data Lane HS-TX 80%-20% Fall time (tF) test.
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Configure and run data lane HS-TX 80%-20% fall time (tF).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 56: Configuration parameters for Data Lane HS-TX 80%-20% Fall time (tF)

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 57: Analysis parameters for Data Lane HS-TX 80%-20% Fall time (tF)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the tF values in pS, and the compare string.
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9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS exit:
THS-TRAIL value

Connections for data lane HS exit: THS-TRAIL value. Click here for information on
connections for the Data Lane HS Exit: THS-TRAIL Value test.
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Configure and run data lane HS exit: THS-TRAIL value.
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.
4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 58: Configuration parameters for Data Lane HS Exit: THS-TRAIL Value

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 59: Analysis parameters for Data Lane HS Exit: THS-TRAIL Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane THS-TRAIL values in nS,
and the compare string.
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9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS exit:
30%-80% Post-EOT rise

test (TREOT)

Connections for data lane HS exit: 30%-80% Post-EOT rise test (TREOT). Click here
for information on connections for the Data Lane HS Exit: 30%–80% Post-EOT
Rise Test (TREOT) test.
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Configure and run data lane HS exit: 30%-80% Post-EOT rise test (TREOT).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 60: Configuration parameters for Data Lane HS Exit: 30%-80% Post-EOT
Rise Test (TREOT)

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 61: Analysis parameters for Data Lane HS Exit: 30%-80% Post-EOT Rise
Test (TREOT)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

 Application examples

TekExpress D-PHY Printable Application Help 105



Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane TREOT value in nS, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS exit:
TEOT value

Connections for data lane HS exit: TEOT value. Click here for information on
connections for the Data Lane HS Exit: TEOT Value test.
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Configure and run data lane HS exit: TEOT value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 62: Configuration parameters for Data Lane HS Exit: 30%-80% Post-EOT
Rise Test (TREOT)

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 63: Analysis parameters for Data Lane HS Exit: 30%-80% Post-EOT Rise
Test (TREOT)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane TREOT value in nS, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing data lane HS exit:
THS-EXIT value

Connections for data lane HS exit: THS-EXIT value. Click here for information on
connections for the Data Lane HS Exit: THS-Exit Value test.
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Configure and run data lane HS exit: THS-EXIT value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 64: Configuration parameters for Data Lane HS Exit: 30%-80% Post-EOT
Rise Test (TREOT)

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 65: Analysis parameters for Data Lane HS Exit: 30%-80% Post-EOT Rise
Test (TREOT)

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Data Lane TREOT value in nS, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

View report for
Group 3 tests

The application automatically displays a report in the Report panel once the test
is successfully completed. A table shows the test name, measurement details, test
result (pass/fail), compliance mode, and analysis time. Save the report as an
MHT file using the File > Save Report As option. The following screen shows
the results for Group 3 tests.
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Group 4 tests

Testing clock lane HS
entry TLPX value

Connections for clock lane HS entry TLPX value. Single-ended clock signal only

Click here for information on connections for the Clock Lane HS Entry TLPX
Value test.
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Configure and run clock lane HS entry TLPX value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

NOTE. This test is not available in the Continuous Clock mode.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 66: Configuration parameters for Clock Lane HS Entry TLPX Value

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 67: Analysis parameters for Clock Lane HS Entry TLPX Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
Trigger Polarity Positive Positive, Negative
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8. Click Limits to view and change the Clock Lane HS Entry TLPX Value in
nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS
entry TCLK-PREPARE

value

Connections for clock lane HS entry TCLK-PREPARE value. test id 1.4.2.

Single-ended clock signal only

Click here for information on connections for the Clock Lane HS Entry TCLK-
PREPARE Value test.
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Configure and run clock lane HS entry TCLK-PREPARE value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

NOTE. This test is not available in the Continuous Clock mode.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 68: Configuration parameters for Clock Lane HS Entry TCLK-PREPARE
Value

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (ns) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 69: Analysis parameters for Clock Lane HS Entry TCLK-PREPARE Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
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Parameter Default User defined mode
Trigger Polarity Positive Positive, Negative

8. Click Limits to view and change the Clock Lane HS Entry TCLK-PREPARE
Value in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS
entry TCLK-PREPARE

+TCLK-ZERO value

Connections for clock lane HS entry TCLK-PREPARE+TCLK-ZERO value. Click
here for information on connections for the Clock Lane HS Entry TCLK-
PREPARE Value test.
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Configure and run clock lane HS entry TCLK-PREPARE+TCLK-ZERO value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

NOTE. This test is not available in the Continuous Clock mode.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO Value is
not available in the Differential Mode.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 70: Configuration parameters for Clock Lane HS Entry TCLK-PREPARE
+TCLK–ZERO Value

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (ns) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 71: Analysis parameters for Clock Lane HS Entry TCLK-PREPARE
+TCLK–ZERO Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Cklp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 
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Parameter Default User defined mode
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

8. Click Limits to view and change the Clock Lane HS Entry TCLK-PREPARE
Value in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS-TX
differential voltages

(VOD(0), VOD(1))

Connections for clock lane HS-TX differential voltages (VOD(0), VOD(1)). Click here
for information on connections for the Clock Lane HS-TX Differential Voltages
(VOD(0), VOD(1)) test.
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Configure and run clock lane HS-TX differential voltages (VOD(0), VOD(1)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 72: Configuration parameters for Clock Lane HS-TX Differential Voltages
(VOD(0), VOD(1))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 73: Analysis parameters for Clock Lane HS-TX Differential Voltages
(VOD(0), VOD(1))

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1 

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1 
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Parameter Default User defined mode
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the Clock Lane VOD(1) and VOD(2)
values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS-TX
differential voltage

mismatch

Connections for clock lane HS-TX differential voltage mismatch. Click here for
information on connections for the Clock Lane HS-TX Differential Voltages
(VOD(0), VOD(1)) test.
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Configure and run clock lane HS-TX differential voltage mismatch.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 74: Configuration parameters for Clock Lane HS-TX Differential Voltage
Mismatch

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 75: Analysis parameters for Clock Lane HS-TX Differential Voltage
Mismatch

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V)
Single-ended probing
Differential probing

 
1 
0.15 

 
Enter a value based on the
test

Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1 

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1 
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Parameter Default User defined mode
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the Clock Lane VOD value in mV, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS-TX
Single-Ended output high

voltages (VOHHS(DP),
VOHHS(DN))

Connections for clock lane HS-TX Single-Ended output high voltages (VOHHS(DP),
VOHHS(DN)). Click here for information on connections for the Clock Lane HS-
TX Single-Ended Output High Voltages (VOHHS(DP), VOHHS(DN)) test.
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Configure and run clock lane HS-TX Single-Ended output high voltages
(VOHHS(DP), VOHHS(DN)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 76: Configuration parameters for Clock Lane HS-TX Single-Ended Output
High Voltages (VOHHS(DP), VOHHS(DN))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 77: Analysis parameters for Clock Lane HS-TX Single-Ended Output High
Voltages (VOHHS(DP), VOHHS(DN))

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable
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Parameter Default User defined mode
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the Clock Lane HS-TX Single-Ended
Output High Voltages DP and DN values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS-TX
static Common-Mode
voltages (VCMTX(1),

VCMTX(0))

Connections for clock lane HS-TX static Common-Mode voltages (VCMTX(1),
VCMTX(0)). Click here for information on connections for the Clock Lane HS-TX
Static Common-Mode Voltages (VCMTX(1), VCMTX(0)) test.
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Configure and run clock lane HS-TX static Common-Mode voltages (VCMTX(1),
VCMTX(0)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1),
VCMTX(0)) test is not available when the selected clock lane probing is
Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 78: Configuration parameters for Clock Lane HS-TX Static Common-Mode
Voltages (VCMTX(1), VCMTX(0))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 79: Analysis parameters for Clock Lane HS-TX Static Common-Mode
Voltages (VCMTX(1), VCMTX(0))

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 
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Parameter Default User defined mode
Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the Common Mode Voltages VTX(0) and
VTX(1) values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS-TX
static Common-Mode

voltage mismatch
(VCMTX(1,0))

Connections for clock lane HS-TX static Common-Mode voltage mismatch
(VCMTX(1,0)). Click here for information on connections for the Clock Lane HS-
TX Static Common-Mode Voltage Mismatch (VCMTX(1,0)) test
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Configure and run clock lane HS-TX static Common-Mode voltage mismatch
(VCMTX(1,0)).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS-TX Static Common-Mode Voltage Mismatch
(VCMTX(1, 0)) test is not available when the selected clock lane probing is
Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 80: Configuration parameters for Clock Lane HS-TX Static Common-Mode
Voltage Mismatch (VCMTX(1,0))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 81: Analysis parameters for Clock Lane HS-TX Static Common-Mode
Voltage Mismatch (VCMTX(1,0))

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 
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Parameter Default User defined mode
Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the Common Mode Voltage Mismatch
values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS-TX
dynamic Common-Level

variations between
50-450 MHz (VCMTX(LF))

Connections for clock lane HS-TX dynamic Common-Level variations between
50-450 MHz (VCMTX(LF)). Click here for information on connections for the Clock
Lane HS-TX Dynamic Common-Level Variations Between 50-450 MHz
(VCMTX(LF)) test
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Configure and run clock lane HS-TX dynamic Common-Level variations between
50-450 MHz (VCMTX(LF)). The Clock Lane HS-TX Dynamic Common-Level
Variations Between 50-450 MHz (VCMTX(LF)) test uses a band pass filter. To
perform the measurement, the application uses both the original waveform
(unfiltered) and the filtered waveform as follows: 

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical
waveform names are like Acq4_Clock Lanes Acquisition with Clock As
Trigger and BandPass Filter_ClockLane_CN.wfmand Acq4_Clock Lanes
Acquisition with Clock As Trigger and BandPass Filter_ClockLane_CP.wfm.

2. Applies a band pass filter on live channels and stores them on the Math
channel. Typical filtered waveform file names are like
ClockLane_FilteredTwoChannelWithClockasTriggerAndBandPassFilter_CN
.WFM and
ClockLane_FilteredTwoChannelWithClockasTriggerAndBandPassFilter_CP.
WFM.

3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms.
However, make sure that the filtered waveforms are in the same folder as the
unfiltered waveforms for these measurements to run correctly in pre-recorded
mode. The filtered waveforms for the measurements must be the ones saved by
the TekExpress application. The measurements will not work as expected if any
other filtered waveforms are used.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS-TX Dynamic Common-Level Variations Between
50-450 MHz (VCMTX(LF)) test is not available when the selected clock lane
probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger and BandPass Filter). The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:
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Table 82: Configuration parameters for Clock Lane HS-TX Dynamic Common-
Level Variations Between 50-450 MHz (VCMTX(LF))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 83: Analysis parameters for Clock Lane HS-TX Dynamic Common-Level
Variations Between 50-450 MHz (VCMTX(LF))

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the Clock Lane HS-TX Dynamic Common-
Level Variations value in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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Testing clock lane HS-TX
dynamic Common-Level

variations above 450 MHz
(VCMTX(HF))

Connections for clock lane HS-TX dynamic Common-Level variations above
450 MHz (VCMTX(HF)). Click here for information on connections for the Clock
Lane HS-TX Dynamic Common-Level Variations Above 450 MHz
(VCMTX(HF)) test
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Configure and run clock lane HS-TX dynamic Common-Level variations above
450 MHz (VCMTX(HF)). The Clock Lane HS-TX Dynamic Common-Level
Variations Above 450 MHz (VCMTX(HF)) test uses a high pass filter. To
perform the measurement, the application uses both the original waveform
(unfiltered) and the filtered waveform as follows: 

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical
waveform names are like Acq5_Clock Lanes Acquisition with Clock As
Trigger and HighPass Filter_ClockLane_CN.wfmand Acq5_Clock Lanes
Acquisition with Clock As Trigger and HighPass Filter_ClockLane_CP.wfm.

2. Applies a high pass filter on live channels and stores them on the Math
channel. Typical filtered waveform file names are like
ClockLane_FilteredTwoChannelWithClockasTriggerAndHighPassFilter_CN
.WFM and
ClockLane_FilteredTwoChannelWithClockasTriggerAndHighPassFilter_CP.
WFM.

3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms.
However, make sure that the filtered waveforms are in the same folder as the
unfiltered waveforms for these measurements to run correctly in pre-recorded
mode. The filtered waveforms for the measurements must be the ones saved by
the TekExpress application. The measurements will not work as expected if any
other filtered waveforms are used. .

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS-TX Dynamic Common-Level Variations Above
450 MHz (VCMTX(HF)) test is not available when the selected clock lane
probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger and HighPass Filter). The following
table lists the compliance mode values and the permitted range of values for
the user-defined mode:
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Table 84: Configuration parameters for Clock Lane HS-TX Dynamic Common-
Level Variations Above 450 MHz (VCMTX(HF))

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 85: Analysis parameters for Clock Lane HS-TX Dynamic Common-Level
Variations Above 450 MHz (VCMTX(HF))

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the Clock Lane HS-TX Dynamic Common-
Level Variations value in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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Testing clock lane HS-TX
20%-80% rise time (tR)

Connections for clock lane HS-TX 20%-80% rise time (tR). Click here for
information on connections for the Clock Lane HS-TX 20%-80% Rise time (tR)
test.
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Configure and run clock lane HS-TX 20%-80% rise time (tR).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 86: Configuration parameters for Clock Lane HS-TX 20%-80% Rise time
(tR)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 87: Analysis parameters for Clock Lane HS-TX 20%-80% Rise time (tR)

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1 

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1 

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 
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Parameter Default User defined mode
Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the tR value in pS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS-TX
80%-20% fall time (tF)

Connections for clock lane HS-TX 80%-20% fall time (tF). Click here for
information on connections for the Clock Lane HS-TX 80%-20% Fall time (tF)
test.
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Configure and run clock lane HS-TX 80%-20% fall time (tF).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 88: Configuration parameters for Clock Lane HS-TX 80%-20% Fall time
(tF)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 89: Analysis parameters for Clock Lane HS-TX 80%-20% Fall time (tF)

Parameter Default User defined mode
Trigger Type
Normal Clock
Continuous Clock

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1 

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1 

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 
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Parameter Default User defined mode
Trigger Time (pS) 500 250, 500 
Trigger Transition
Normal Clock
Continuous Clock

 
Greater Than
Not Applicable

 
Greater Than, Less Than
Not Applicable

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Normal Clock
Continuous Clock

 
Occurs
Not Applicable

 
Occurs, Logic
Not Applicable

8. Click Limits to view and change the tF values in pS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS exit:
TCLK-TRAIL value

Connections for clock lane HS exit: TCLK-TRAIL value. Click here for information
on connections for the Clock Lane HS Exit: TCLK-TRAIL Value test.
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Configure and run clock lane HS exit: TCLK-TRAIL value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 90: Configuration parameters for Clock Lane HS Exit: TCLK-TRAIL Value

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 91: Analysis parameters for Clock Lane HS Exit: TCLK-TRAIL Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs

8. Click Limits to view and change the Clock Lane THS-TRAIL values in nS,
and the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.
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10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS exit:
30%-85% Post-EoT rise

time (TREOT)

Connections for clock lane HS exit: 30%-85% Post-EoT rise time (TREOT). Click
here for information on connections for the Clock Lane HS Exit: 30%–85% Post-
EoT Rise Time (TREOT) test.
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Configure and run clock lane HS exit: 30%-85% Post-EoT rise time (TREOT).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 92: Configuration parameters for Clock Lane HS Exit: 30%-85% Post-EoT
Rise Time (TREOT)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 93: Analysis parameters for Clock Lane HS Exit: 30%-85% Post-EoT Rise
Time (TREOT)

Parameter Default User defined mode
Trigger Type Transition, Edge Transition, Edge
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

8. Click Limits to view and change the Clock Lane TREOT value in nS, and
the compare string.
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9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS exit:
TEOT value

Connections for clock lane HS exit: TEOT value. Click here for information on
connections for the Clock Lane HS Exit: TEOT Value test.
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Configure and run clock lane HS exit: TEOT value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 94: Configuration parameters for Clock Lane HS Exit: 30%-85% Post-EoT
Rise Time (TREOT)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 95: Analysis parameters for Clock Lane HS Exit: 30%-85% Post-EoT Rise
Time (TREOT)

Parameter Default User defined mode
Trigger Type Transition, Edge Transition, Edge
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

8. Click Limits to view and change the Clock Lane TREOT value in nS, and
the compare string.
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9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS exit:
THS-EXIT value

Connections for clock lane HS exit: THS-EXIT value. Click here for information on
connections for the Clock Lane HS Exit: THS-Exit Value test.
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Configure and run clock lane HS exit: THS-EXIT value.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 96: Configuration parameters for Clock Lane HS Exit: 30%-85% Post-EoT
Rise Time (TREOT)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 97: Analysis parameters for Clock Lane HS Exit: 30%-85% Post-EoT Rise
Time (TREOT)

Parameter Default User defined mode
Trigger Type Transition, Edge Transition, Edge
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

8. Click Limits to view and change the Clock Lane TREOT value in nS, and
the compare string.
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9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS
clock instantaneous

(UIINST)

Connections for clock lane HS clock instantaneous (UIINST). Click here for
information on connections for the Clock Lane HS Clock Instantaneous
(UIINST) test.
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Configure and run clock lane HS clock instantaneous (UIINST).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended .

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 98: Configuration parameters for Clock Lane HS Clock Instantaneous
(UIINST)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 99: Analysis parameters for Clock Lane HS Clock Instantaneous (UIINST)

Parameter Default User defined mode
UI INST MIN (nS) 1.25 Greater than or equal to

1.25 and less than or equal to
12.5 

Trigger Type
Single-ended probing
Differential probing

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1 

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1 

Application examples  

146  TekExpress D-PHY Printable Application Help



Parameter Default User defined mode
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Trigger Time (pS) 500 250, 500 
Trigger Transition
Single-ended probing
Differential probing

 
Greater Than
NA

 
Greater Than, Less Than
NA

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Single-ended probing
Differential probing

 
Occurs
NA

 
Occurs, Logic
NA

8. Click Limits to view and change the Maximum (UIINST) values in nS, and
the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock lane HS
clock delta UI (ΔUI)

Connections for clock lane HS clock delta UI (ΔUI). Click here for information on
connections for the Clock Lane HS Clock Delta UI (ΔUI) test.

 Application examples

TekExpress D-PHY Printable Application Help 147



Configure and run clock lane HS clock delta UI (ΔUI).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended .

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Clock
Lanes Acquisition with Clock as Trigger). The following table lists the
compliance mode values and the permitted range of values for the user-
defined mode:

Table 100: Configuration parameters for Clock Lane HS Clock Delta UI(ΔUI)

Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300 
Vertical Position (div) –2.6 +3 to –3 
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 101: Analysis parameters for Clock Lane HS Clock Delta UI(ΔUI)

Parameter Default User defined mode
UI INST MIN (nS) 1.25 Greater than or equal to

1.25 and less than or equal to
12.5 

Trigger Type
Single-ended probing
Differential probing

 
Transition
Edge

 
Transition
Edge

Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1 

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1 

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1 

Application examples  

148  TekExpress D-PHY Printable Application Help



Parameter Default User defined mode
Trigger Time (pS) 500 250, 500 
Trigger Transition
Single-ended probing
Differential probing

 
Greater Than
NA

 
Greater Than, Less Than
NA

Trigger Slope Negative Positive, Negative, Either
Trigger If Violation
Single-ended probing
Differential probing

 
Occurs
NA

 
Occurs, Logic
NA

8. Click Limits to view and change the Maximum (UIINST) values in nS, and
the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.
11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp

and Dn) and Clock (Clkp and Clkn) sources.
12. Click Run to start the test. The Acquire panel shows the progress and status

of the test as it runs.

View report for
Group 4 tests

The application automatically displays a report in the Report panel once the test
is successfully completed. A table shows the test name, measurement details, test
result (pass/fail), compliance mode, and analysis time. Save the report as an
MHT file using the File > Save Report As option. The following screen shows
the results for Group 4 tests.
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Group 5 tests

Testing HS entry TCLK
PREValue

Connections for HS entry TCLK PREValue. Click here for information on
connections for the HS Entry TCLK PREValue test.
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Configure and run HS entry TCLK PREValue.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

NOTE. The HS Entry TCLK PREValue test is not available in the Clock
Continuous Mode.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 102: Configuration parameters for HS Entry TCLK PREValue

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 103: Analysis parameters for HS Entry TCLK PREValue

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
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Parameter Default User defined mode
Trigger If Violation Occurs Occurs, Logic

8. Click Limits to view and change the HS Entry TCLK PREValue in nS, and
the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing HS exit TCLK
POSTValue

Connections for HS exit TCLK POSTValue. Click here for information on
connections for the HS Exit TCLK POSTValue test.
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Configure and run HS exit TCLK POSTValue.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

NOTE. The HS Exit TCLK POSTValue test is not available in the Clock
Continuous Mode.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 104: Configuration parameters for HS Exit TCLK POSTValue

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

 
+3 to –3 
–3 to +3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (ns) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 

7. Click Analyze. View and change the following analysis parameters:

Table 105: Analysis parameters for HS Exit: TCLK-POST Value

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
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Parameter Default User defined mode
Trigger If Violation Occurs Occurs, Logic

8. Click Limits to view and change the HS Exit TCLK POSTValue in nS, and
the compare string.

9. Click Comments to enter comments. The comments are shown in the test
report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Testing clock rising edge
alignment to first payload

bit

Connections for clock rising edge alignment to first payload bit. Click here for
information on connections for the Clock Rising Edge Alignment to First
Payload Bit test.
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Configure and run clock rising edge alignment to first payload bit.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

3. Select Clock Lane Probing as Single-ended .

NOTE. The Clock Rising Edge Alignment to First Payload Bit test is not
available when the selected clock lane probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 106: Configuration parameters for Clock Rising Edge Alignment to First
Payload Bit

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)

–2.6 +3 to –3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 
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7. Click Analyze. View and change the following analysis parameters:

Table 107: Analysis parameters for Clock Rising Edge Alignment to First
Payload Bit

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Clkp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

NOTE. The Limits tab has no configurable parameters.

8. Click Comments to enter comments. The comments are shown in the test
report.

9. Click Save to effect the changes, or click Cancel.

10. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

11. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

12. Follow the on-screen prompt and complete the test.

Testing Data-to-Clock
skew (TSKEW[TX])

Connections for Data-to-Clock skew (TSKEW[TX]). Click here for information on
connections for the Data-to-Clock Skew (TSKEW[TX]) test.
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Configure and run Data-to-Clock skew (TSKEW[TX]).

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

3. Select Clock Lane Probing as Single-ended .

NOTE. The Clock Rising Edge Alignment to First Payload Bit test is not
available when the selected clock lane probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is Base Spec 1.2.

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Data
and Clock Lanes Acquisition with Data as Trigger). The following table lists
the compliance mode values and the permitted range of values for the user-
defined mode:

Table 108: Configuration parameters for Clock Rising Edge Alignment to First
Payload Bit

Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200 
Vertical Position for Data (div) –2.6 +3 to –3 
Vertical Position for Clock
(div)

–2.6 +3 to –3 

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12 
Sample Rate (GS/s) 12.5 7.5, 10, 12.5 
Record Length 1000000 100000 to 10000000 
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7. Click Analyze. View and change the following analysis parameters:

Table 109: Analysis parameters for Clock Rising Edge Alignment to First
Payload Bit

Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Dp Dp, Dn, Clkp, Clkn
Trigger Upper Level (V) 1 Enter a value based on the

test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1 
Trigger Time (pS) 500 250, 500 
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic

NOTE. The Limits tab has no configurable parameters.

8. Click Comments to enter comments. The comments are shown in the test
report.

9. Click Save to effect the changes, or click Cancel.

10. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp
and Dn) and Clock (Clkp and Clkn) sources.

11. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

12. Follow the on-screen prompt and complete the test.

View report for
Group 5 tests

The application automatically displays a report in the Report panel once the test
is successfully completed. A table shows the test name, measurement details, test
result (pass/fail), compliance mode, and analysis time. Save the report as an
MHT file using the File > Save Report As option. The following screen shows
the results for Group 5 tests.
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Group 6 tests

Connections for
Group 6 tests

Click here for information on connections for Group 6 Tests.

Configure and run
Group 6 tests

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended or Differential.

NOTE. ULPS Entry, Clock Lane Probing as Single-ended is needed.

4. Select the Test Mode as Normal.

5. The Version default value is Base Spec 1.2.

6. Select the test and click Configure.

7. Acquire tab in the Configuration Panel, lists the following parameters. The
following table lists the compliance mode values (default), while in user-
defined mode, these are under user control for configuration:
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Table 110: Acquire parameters for INIT: LP-TX test initialization period

Parameter Default User defined mode
Vertical Scale (mV) 200 Range: 100, 200, 300 
Vertical Position for Data (div) –2.6 
Vertical Position for Clock
(div)
Single-ended probing
Differential probing

 
–2.6 
+2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 32 Range: 8, 10, 12,16, 32 
Sample Rate (GS/s) 3.125 Range: 3.125, 7.5 ,10 , 12.5 
Record length 1 M

Table 111: Acquire parameters for ULPS Entry test

Parameter Default User defined mode
Vertical Scale (mV) 200 Range: 100, 200, 300 
Vertical Position for Data (div) –2.6 
Vertical Position for Clock
(div) (Single-ended probing )

–2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 8 Range: 8, 10, 12 
Sample Rate (GS/s) 12.5 Range: 7.5 ,10 , 12.5 
Record length 1 M

Table 112: Acquire parameters for ULPS Exit test

Parameter Default User defined mode
Vertical Scale (mV) 200 Range: 100, 200, 300 
Vertical Position for Data (div) –2.6 
Vertical Position for Clock
(div) (Single-ended probing )

–2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 200 Range: 8, 10, 12, 200 
Sample Rate (GS/s) 3.125 Range: 3.125, 7.5 ,10 , 12.5 
Record length 6.25 

Table 113: Acquire parameters for Bus Turn Around (BTA) tests

Parameter Default User defined mode
Vertical Scale (mV) 200 Range: 100, 200, 300 
Vertical Position for Data (div) –2.6 
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Parameter Default User defined mode
Vertical Position for Clock
(div) (Single-ended probing )

–2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 1.6 Range: 1.6, 4, 8, 10, 12, 200 
Sample Rate (GS/s) 12.5 Range: 7.5 ,10 , 12.5 
Record length 200 K
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8. Click Analyze. View and change the following analysis parameters:

Table 114: Analyze parameters INIT: LP-TX initialization period

Parameter Default
Trigger type Width
Trigger Source Dp
Trigger Level (V) 50%
Trigger Polarity Positive
Upper Limit (μs) 300 
Lower Limit (μs) 25 
Trigger Slope Positive

Table 115: Analyze parameters ULPS Entry

Parameter Default
Trigger type Edge
Trigger Source Dp
Level 50%
Slope Negative
Horizontal Delay Mode On
Ref Point 50%
A Trigger Level 500 mV
Acquisition Delay 20 ms

Table 116: Analyze parameters ULPS Exit

Parameter Default
Trigger Type Edge
Trigger Source Dp
Level 50%
Slope Positive
Horizontal Trigger Position 20%

Table 117: Analyze parameters Bus Turn Around (BTA) tests

Parameter Default
Trigger type Edge
Trigger Source Dp
Level 50%
Slope Negative
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NOTE. Edge, Width and Transition triggers are available for all tests in user-
defined mode.

9. Click Limits to view and change limit parameters and the compare string.

10. Use the Comments section to enter comments, which are added to the Test
report.

11. Click Save to keep the changes, or click Cancel.

12. Click the Acquire tab to view the acquisition parameters.

13. Select the Data (Dp and Dn) and Clock (Clkp and Clkn) sources.

14. Click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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TekExpress programmatic interface

About the programmatic interface
The Programmatic interface allows you to seamlessly integrate the TekExpress
test automation application with the high-level automation layer. This also allows
you to control the state of TekExpress application running on a local or a remote
computer. See Server and client proxy objects.

For simplifying the descriptions, the following terminologies are used in this
section:

■ TekExpress Client: A High level automation application that communicates
with TekExpress using TekExpress Programmatic Interface.

■ TekExpress Server: The TekExpress application when being controlled by
TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for
TekExpress Client. TekExpress provides a client library for TekExpress clients to
use the programmatic interface. The TekExpress client library is inherited
from .Net MarshalByRef class to provide the proxy object for the clients. The
TekExpress client library maintains a reference to the TekExpress Server and this
reference allows the client to control the server state.
 

 

Click the following links to get details on them:

What does one need to have to develop TekExpress Client?

While developing TekExpress Client one needs to use the TekExpressClient.dll.
The client can be a VB .Net, C# .Net, TestStand or web application. The
examples for interfaces in each of these applications are in Samples folder.
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References required

TekExpressClient.dll has internal reference to IIdlglib.dll and
IRemoteInterface.dll.

IIdlglib.dll has a reference to TekDotNetLib.dll.

IRemoteInterface.dll provides the interfaces required to perform the remote
automations. It is an interface that forms the communication line between the
server and the client.

IIdlglib.dll provides the methods to generate and direct the secondary dialog
messages at the client-end.

NOTE. The end-user client application does not need any reference to above
mentioned DLL files. It is essential to have these DLLs (IRemoteInterface.dll,
IIdlglib.dll and TekDotNetLib.dll) in same folder location as that of
TekExpressClient.dll.

What steps does a client need to follow?

The following are the steps that a client needs to follow to use the
TekExpressClient.dll to programmatically control the server:

A client UI must be developed to access the interfaces exposed through the
server. This client needs to load TekExpressClient.dll to access the interfaces.
Once the TekExpressClient.dll is loaded, the client UI can call the specific
functions to run the operations requested by the client. Once the client is up and
running, it must do the following to run a remote operation:

1. The client needs to provide the IP address of the PC at which the server is
running in order to connect to the server.

2. The client needs to lock the server application to avoid conflict with any
other Client that may try to control the server simultaneously. “Lock” would
also disable all user controls on server so that server state cannot be changed
by manual operation.

3. If any other client tries to access a server which is locked, it will get a
notification that the server is locked by another client.

4. When the client has connected to and locked the server, the client can access
any of the programmatic controls to run the remote automations.

5. Once the client operations are completed, the server needs to be “unlocked”
by the client.
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Server and client proxy objects

Remote proxy object The server exposes a remote object to let the remote client access and perform the
server side operations remotely. The proxy object is instantiated and exposed at
the server-end through marshalling.
 

 

The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof
(TekExpressRemoteInterface), “TekExpress Remote interface”,
WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side.
The client gets the reference to this object when the client gets connected to the
server.

For example,

//Get a reference to the remote object

remoteObject =
(IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),
URL.ToString());
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Client proxy object Client exposes a proxy object to receive certain information.
 

 

For example,

//Register the client proxy object

WellKnownServiceTypeEntry[] e =
RemotingConfiguration.GetRegisteredWellKnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKnownServiceType(typeof(ClientInterface)
, “Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling

RemotingServices.Marshal(clientInterface, "Remote Client Inteface");

The client proxy object is used for the following:

1. To get the secondary dialog messages from the server.
2. To get the file transfer commands from the server while transferring the

report.

Click here to see examples.
clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);

clientObject.clientIntf.TransferBytes(buffer, read, fileLength);

To know more on the topics below, click the links.

Secondary Dialog Message Handling
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The secondary dialog messages from the Secondary Dialog library are redirected
to the client-end when a client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to
be displayed is checked and if a remote connection is detected, the messages are
directed to the remote end.

File Transfer Events
When the client requests the transfer of the report, the server reads the report and
transfers the file by calling the file transfer methods at the client-end.

Client programmatic interface: An example
An example of the client programmatic interface is described and shown as
follows:
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1. Connect to a server or remote object using the programmatic interface
provided.

2. Get the client ID that is created when connecting to the remote object. This
client ID is one of the required parameters to communicate with the server.

NOTE. Server identifies the client with this ID only and rejects any request if
the ID is invalid.
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3. Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the
client only if application is locked.

4. Register for receiving notifications on status change events on the server. To
register you need to give a handler as a parameter.

NOTE. Whenever there is a change in the status of the server, all the clients
registered with the server receive a notification from the server.

5. Select the tests that you want to run through the programmatic interface.

6. Set the necessary parameters for each test.

7. Run the tests.

8. Poll for the status of the application.

NOTE. You can skip this step if you are registered for the status change
notification and when the status is Ready.

9. After completing the tests, get the results.

10. Create a report or display the results and verify or process the results.

11. Unlock the server once you complete all the tasks.

12. Disconnect from the remote object.

Handler of Status Change
Notification

1. Get the status. If the status is Wait or Error, get the information which
contains the title, message description, and the expected responses for the
status.

2. Perform the actions based on the status information.
3. Set the response as expected.
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D-PHY application command arguments and queries
Connect through an IP address

Lock the server

Disable the popups

Set or get the DUT ID

Set the configuration parameters for a suite or measurement

Query the configuration parameters for a suite or measurement

Select a measurement

Select a suite

Select a channel

Configure the selected measurement

Run with set configurations or stop the run operation

Get or set the timeout value

Wait for the measurement to complete

After the measurement is complete

Save, recall, or check if a session is saved

Unlock the server

Disconnect from the server

Select a lane

Assign input signals to scope channels

Assign each lane input signal to RF switch ports

Enable disable automation of the lane switching with RF switch

Handle error codes
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Connect through an IP
address

Command name Parameters Description Return Value Example
Connect() string ipAddress

out string clientID
This method
connects the client
to the server. Note

NOTE. The server
must be active and
running for the
client to connect to
the server. Any
number of clients
can be connected
to the server at a
time.

The client provides
the IP address to
connect to the
server.
The server
provides a unique
client identification
number when
connected to it.

Return value is
either True or
False.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as
boolean
returnval =
m_Client.Connect(
ipaddress,m_client
ID)

string ipAddress

Name Type Direction Description
ipAdress string IN The ip address of the

server to which the
client is trying to
connect to. This is
required to establish
the connection between
the server and the
client.

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Lock the server Command name Parameters Description Return Value Example
LockSession() string clientID This method locks

the server. Note

NOTE. When the
client tries to lock a
server that is
locked by another
client, the client
gets a notification
that the server is
already locked and
it must wait until
the server is
unlocked. If the
client locks the
server and is idle
for a certain
amount of time
then the server is
unlocked
automatically from
that client.

The client must
call this method
before running any
of the remote
automations. The
server can be
locked by only one
client.

String value that
gives the status of
the operation after
it has been
performed.
The return value is
"Session
Locked...” on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval =
m_Client.LockServ
er(clientID)
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out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Disable the popups Command name Parameters Description Return Value Example
SetVerboseMode() string clientID

bool _verbose
This method sets
the verbose mode
to either true or
false.
When the value is
set to true, then
any of the
message boxes
appearing during
the application will
be routed to the
client machine
which is controlling
TekExpress.
When the value is
set to false, then
all the message
boxes are shown
on the server
machine.

String that gives
the status of the
operation after it
has been
performed.
When Verbose
mode is set to
true, the return
value is “Verbose
mode turned on.
All dialog box will
be shown to
client ...”.
When Verbose
mode is set to
false, the return
value is “Verbose
mode turned off.
All dialog box will
be shown to
server ...”.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Verbose mode is
turned on
return=m_Client.S
etVerboseMode(cli
entID, true)
Verbose mode is
turned off
returnval=m_Clien
t.SetVerboseMod
e(clientID, false)
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out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

bool_verbose

Name Type Direction Description
_verbose bool IN Specifies whether the

verbose mode should
be turned ON or OFF.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Set or get the DUT ID Command name Parameters Description Return Value Example
SetDutId() string clientID

string dutName
This method
changes the DUT
ID of the set up.
The client must
provide a valid
DUT ID.

String that gives
the status of the
operation after it
has been
performed.
Return value is
“DUT Id
Changed...” on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
return=m_Client.S
etDutId(clientID,de
siredDutId) Note

NOTE. If the
dutName
parameter is null,
the client is
prompted to
provide a valid
DUT ID.

GetDutId() string clientID
string dutId

This method gets
the DUT ID of the
current set up.

String that gives
the status of the
operation after it
has been
performed.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
return=m_Client.G
etDutid(clientID,
out DutId)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string dutName

Name Type Direction Description
dutName string IN The new DUT ID of the

setup.

string dutId

Name Type Direction Description
dutId string OUT The DUT ID of the

setup.
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The dutId parameter is set after the server processes the request.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

TekExpress programmatic interface  

178  TekExpress D-PHY Printable Application Help



Set the configuration
parameters for a suite or

measurement

Command name Parameters Description Return Value Example
SetGeneralParam
eter

string clientID
string device
string suite
string test
string
parameterString

This method sets
the number of
video lanes for the
selected
measurement.

NOTE. Using this
command we can
select a lane,
channel, or source
type.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"" (an empty
String) on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Select Channel

Select Channel
Example

returnval=mClient.
SetGeneralParame
ter(clientID, "D-
PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time", "Lane5
Connected
to:Data:Dn$CH1")
Select
Measurement
Method

Select
Measurement
Method Example

returnval=mClient.
SetGeneralParame
ter(clientID, "D-
PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time",
"Measurement
Method
$Automatic")

SetAnalyzeParam
eter()

string clientID
string device
string suite
string test
string
parameterString

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

The return value is
"" (an empty
String) on
success.

m_Client = new
Client() //
m_Clientis a
reference to the
Client class in the
Client DLL
returnval as string
Configure Analyze
parameters for
Data Lane Rise
Time
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Command name Parameters Description Return Value Example
SetAcquireParame
ter()

string clientID
string device
string suite
string test
string
parameterString

This method sets
the configuration
parameters in the
Acquire panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal =
remoteObject.Set
AcquireParameter(
id, device, suite,
test,
parameterString)
if ((OP_STATUS)
returnVal !=
OP_STATUS.SUC
CESS)
return
CommandFailed(r
eturnVal)

Configure Acquire
Parameters for
Data Lane Rise
Time

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.
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string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Configure Analyze Parameters for Data Lane Rise Time Example

Parameter Example
Trigger Type returnval =

mClient.SetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Type$Transition")

Trigger Source returnval =
mClient.SetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Source$Ch1")

Trigger Upper Level (V) returnval =
mClient.SetAnalyzeParameter(clientID,"D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Trigger Upper Level (V)$1")

Trigger Lower Level (V) returnval =
mClient.SetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Lower Level (V)$0.05")

Trigger Time (ps) returnval =
mClient.SetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Time (pS)$500")

Trigger Transition returnval =
mClient.SetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Transition$Greater Than")
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Parameter Example
Trigger Slope returnval =

mClient.SetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Slope$Positive)

Trigger If Violation returnval =
mClient.SetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger If Violation$Occurs")

Data Lane Rise Time Configure Parameter Example

Parameter Example
Vertical Scale (mV) returnval =

mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Scale (mV)
$200")

Vertical Position (div) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Position (div)$–
2.6")

Vertical Offset (V) returnval =
mClient.SetAcquireParameter(clientID,"D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Offset (V)$0")

Horizontal Scale (us) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Horizontal Scale (us)$8")

Sample Rate (GS/s) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Sample Rate (GS/s)
$12.5")

Record Length returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Record Length$500000")
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Query the configuration
parameters for a suite or

measurement

Command name Parameters Description Return Value Example
GetGeneralParam
eter()

string clientID
string device
string suite
string test
string
parameterString

This method gets
the general
configuration
parameters for a
given suite or
measurement.

The return value is
the general
configuration
parameter for a
given suite or
measurement that
is set.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Query Channel

Query Channel
Example

returnval=mClient.
GetGeneralParame
ter(clientID, "D-
PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time", "Lane5
Connected
to:Data:Dn")
Query
Measurement
Method

Query
Measurement
Method Example

returnval=mClient.
GetGeneralParame
ter(clientID, "D-
PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time",
"Measurement
Method")

GetAnalyzeParam
eter()

string clientID
string device
string suite
string test
string
parameterString

This method gets
the configuration
parameters set in
the Analyze panel
of the
Configuration
Panel dialog box
for a given suite or
measurement.

The return value is
the configuration
parameter set in
the Analyze panel
of the
Configuration
Panel dialog box
for a given suite or
measurement.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Query Analyze
Parameters for
Data Lane Rise
Time

GetAcquireParam
eter()

string clientID
string device
string suite
string test
string
parameterString

This method gets
the configuration
parameters set in
the Acquire panel
for a given suite or
measurement.

The return value is
the configuration
parameter set in
the Acquire panel
for a given suite or
measurement.

Query Acquire
Parameters for
Data Lane Rise
Time
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out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Query Data Lane Rise Time Acquire Parameter Examples

Parameter Example
Vertical Scale (mV) returnval =

mClient.GetAcquireParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data Lane Rise Time$Vertical Scale
(mV)")

Vertical Position (div) returnval =
mClient.GetAcquireParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data Lane Rise Time$Vertical Position
(div)")

Vertical Offset (V) returnval =
mClient.GetAcquireParameter(clientID,"D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Offset (V)")

Horizontal Scale (us) returnval =
mClient.GetAcquireParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data Lane Rise Time$Horizontal Scale
(us)")

Sample Rate (GS/s) returnval =
mClient.GetAcquireParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data Lane Rise Time$Sample Rate (GS/
s)")

Record Length returnval =
mClient.GetAcquireParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data Lane Rise Time$Record Length")

Query Data Lane Rise Time Analyze Parameter Examples

Parameter Example
Trigger Type returnval =

mClient.GetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Type")

Trigger Source returnval =
mClient.GetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Source")

Trigger Upper Level (V) returnval =
mClient.GetAnalyzeParameter(clientID,"D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Trigger Upper Level (V)")
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Parameter Example
Trigger Lower Level (V) returnval =

mClient.GetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Lower Level (V)")

Trigger Time (ps) returnval =
mClient.GetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Time (pS)")

Trigger Transition returnval =
mClient.GetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Transition")

Trigger Slope returnval =
mClient.GetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Slope)

Trigger If Violation returnval =
mClient.GetAnalyzeParameter(clientID, "D-
PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger If Violation")

Select a measurement Command name Parameters Description Return Value Example
SelectTest() string clientID

string device
string suite
string test
bool isSelected

This method
selects or
deselects a given
test.
Setting parameter
isSelected to true,
you can select a
measurement.
Setting parameter
isSelected to false,
you can deselect a
measurement.

String that
displays the status
of the operation
after it has been
performed.
The return value is
"" (an empty
String) on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Select
Measurement
(Data Lane Rise
Time):
returnval=m_Clien
t.SelectTest(clientI
D, "D-PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time", true)
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out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

bool isSelected

Name Type Direction Description
isSelected bool IN Selects or deselects a

test.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Select a suite Command name Parameters Description Return Value Example
SelectSuitet() string clientID

string device
string suite
bool isSelected

This method
selects or
deselects a given
suite.
Setting parameter
isSelected to true,
you can select a
suite.
Setting parameter
isSelected to false,
you can deselect a
suite.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"" (an empty
String) on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Select Suite
(Default):
returnval=m_Clien
t.SelectTest(clientI
D, "D-PHY",
"Transmitter", true)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

bool isSelected

Name Type Direction Description
isSelected bool IN Selects or deselects a

test.
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Select a channel Command name Parameters Description Return Value Example
SetGeneralParam
eter()

string clientID
string device
string suite
string test
string
parameterString

This method sets
the parameters
that are not
specific to any
given test.

NOTE. Using this
command we can
select a lane,
channel, or source
type.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"" (an empty
String) on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Select Channel
Select
Measurement
Method

SetAnalyzeParam
eter()

string clientID
string device
string suite
string test
string
parameterString

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

The return value is
"" (an empty
String) on
success.

m_Client = new
Client() //
m_Clientis a
reference to the
Client class in the
Client DLL
returnval as string
Configure Analyze
parameters for
Data Lane Rise
Time

SetAcquireParame
ter()

string clientID
string device
string suite
string test
string
parameterString

This method sets
the configuration
parameters in the
Acquire panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal =
remoteObject.Set
AcquireParameter(
id, device, suite,
test,
parameterString)
if ((OP_STATUS)
returnVal !=
OP_STATUS.SUC
CESS) return
CommandFailed(r
eturnVal)

Configure Acquire
Parameters for
Data Lane Rise
Time
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out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.

Select Channel Example

returnval=mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Lane5 Connected to:Data:Dn$CH1")

Select Measurement Method Example

returnval=mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Measurement Method$Automatic")
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Configure Analyze parameters for Data Lane Rise Time Example

Parameter Example
Trigger Type returnval=mClient.SetAnalyzeParameter(clientID

, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Type$Transition")

Trigger Source returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Source$Ch1")

Trigger Upper Level (V) returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Upper Level (V)$1")

Trigger Lower Level (V) returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Lower Level (V)$0.05")

Trigger Time (pS) returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "TriggerTime (pS)$500")

Trigger Transition returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Transition$Greater Than")

Trigger Slope returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Slope$Positive")

Trigger If Violation returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger If Violation$Occurs")

Configure Acquire Parameters

Parameter Example
Vertical Scale (mV) returnval =

mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Scale (mV)
$200")

Vertical Position (div) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Position (div)$–
2.6")

Vertical Offset (V) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Offset (V)$0")
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Parameter Example
Horizontal Scale (us) returnval =

mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Horizontal Scale (us)$8")

Sample Rate (GS/s) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Sample Rate (GS/s)
$12.5")

Record Length returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Record Length$500000")

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Configure the selected
measurement

Command name Parameters Description Return Value Example
SetAnalyzeParam
eter()

string clientID
string device
string suite
string test
string
parameterString

This method sets
the Analyze
parameters
(Configuration
parameters) for a
given test.

The return value is
"" (an empty
String) on
success.

m_Client = new
Client() //
m_Clientis a
reference to the
Client class in the
Client DLL
returnval as string
Configure Analyze
Parameters for
Data Lane Rise
Time

SetAcquireParame
ter()

string clientID
string device
string suite
string test
string
parameterString

This method sets
the Acquire
parameters in the
Acquire panel of
the Configure
Dialog box for a
given test.

returnVal =
remoteObject.Set
AcquireParameter(
id, device, suite,
test,
parameterString)
if ((OP_STATUS)
returnVal !=
OP_STATUS.SUC
CESS) return
CommandFailed(r
eturnVal)

m_Client = new
Client() //
m_Clientis a
reference to the
Client class in the
Client DLL
returnval as string
Configure Acquire
Parameters for
Data Lane Rise
Time

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.
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string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.

Data Lane Rise Time Configure Parameter Example

Parameter Example
Vertical Scale (mV) returnval =

mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Scale (mV)
$200")

Vertical Position (div) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Position (div)$–
2.6")

Vertical Offset (V) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Vertical Offset (V)$0")

Horizontal Scale (us) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Horizontal Scale (us)$8")

Sample Rate (GS/s) returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Sample Rate (GS/s)
$12.5")

Record Length returnval =
mClient.SetAcquireParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time",
"Data Lane Rise Time$Record Length$500000")
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Data Lane Rise Time Analyze Parameter Example

Parameter Example
Trigger Type returnval=mClient.SetAnalyzeParameter(clientID

, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Type$Transition")

Trigger Source returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Source$Ch1")

Trigger Upper Level (V) returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Upper Level (V)$1")

Trigger Lower Level (V) returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Lower Level (V)$0.05")

Trigger Time (pS) returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "TriggerTime (pS)$500")

Trigger Transition returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Transition$Greater Than")

Trigger Slope returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger Slope$Positive")

Trigger If Violation returnval=mClient.SetAnalyzeParameter(clientID
, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Trigger If Violation$Occurs")

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Run with set
configurations or stop the

run operation

Command name Parameters Description Return Value Example
Run() string clientID Runs the selected

tests. Note

NOTE. When the
run is performed,
the status of the
run is updated
periodically using a
timer.

Once the server is
set up and is
configured, it can
be run remotely
using this function.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"Run started..." on
success.

m_Client = new
Client() //
m_Clientis a
reference to the
Client class in the
Client DLL
returnval as string
returnval=m_Clien
t.Run(clientID)

Stop() string clientID Stops the currently
running tests. Note

NOTE. When the
session is stopped,
the client is
prompted to stop
the session and is
stopped at the
consent.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"Stopped..." on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.Stop(clientID)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Get or set the timeout
value

Command name Parameters Description Return Value Example
GetTimeOut() string clientID Returns the

current timeout
period set by the
client.

String that gives
the status of the
operation after it
has been
performed.
The default return
value is 1800000.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.GetTimeOut()

SetTimeOut() string clientID
string time

Sets a timeout
period specified by
client. After expiry
of this timeout
period, the server
is automatically
unlocked.

String that gives
the status of the
operation after it
has been
performed.
On success the
return value is
“TimeOut Period
Changed”.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.SetTimeOut(clien
tID,
desiredTimeOut)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string time

Name Type Direction Description
time string IN The time in seconds

which refers to the
timeout period.

The time parameter gives the timeout period, that is the time the client is allowed
to be locked and idle. After the timeout period if the client is still idle, it gets
unlocked.

The time parameter should be a positive integer. Else, the client is prompted to
provide a valid timeout period.
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Wait for the test to
complete

The commands in this group are executed while tests are running. The
GetCurrentStateInfo() and SendResponse() commands are executed when
application is running and in wait state.

Command name Parameters Description Return Value Example
ApplicationStatus() string clientID This method gets

the status of the
server application.
The states at a
given time are
Ready, Running,
Paused, Wait, or
Error.

Ready: Test
configured and
ready to start.

Running: Test
running.

Paused: Test
paused.

Wait: A popup that
needs your inputs.

Error: An error is
occurred.

String value that
gives the status of
the server
application.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.ApplicationStatu
s(clientID)

QueryStatus() string clientID
out string[] status

It is an interface
for the user to
transfer Analyze
panel status
messages from
the server to the
client.

String that gives
the status of the
operation after it
has been
performed.
On success the
return value is
“Transferred...”.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnVal=m_Clien
t.QueryStatus(clie
ntID, out
statusMessages)
if
((OP_STATUS)ret
urnVal ==
OP_STATUS.SUC
CESS)
return “Status
updated...”
else
return
CommandFailed(r
eturnVal)
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Command name Parameters Description Return Value Example
GetCurrentStateInf
o()

NOTE. This
command is used
when the
application is
running and is in
the wait or error
state.

string clientID
out string caption
out string
message
out string[]
buttonTexts

This method gets
the additional
information of the
states when the
application is in
Wait or Error state.
Except client ID,
all the others are
out parameters.

This command
does not return
any value.
This function fills
up the out
parameters that
are passed when
invoking this
function.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
m_Client.GetCurre
ntStateInfo(clientI
D,
caption,message,
buttonTexts)

SendResponse()

NOTE. This
command is used
when the
application is
running and is in
the wait or error
state.

string clientID
out string caption
out string
message
string response

After receiving the
additional
information using
the method
GetCurrentStateInf
o(), the client can
decide on the
response to send
and send the
response to the
application using
this function. The
response should
be one of the
strings that was
earlier received as
a string array in
the
GetCurrentStateInf
o function.The
_caption and
_message should
match the
information
received earlier in
the
GetCurrentStateInf
o function.

This command
does not return
any value.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
m_Client.SendRes
ponse(clientID,
caption,message,
response)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 
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out string[] status

Name Type Direction Description
status string array OUT The list of status

messages generated
during run.

out string caption

Name Type Direction Description
caption String OUT The wait state or error

state message sent to
you.

out string message

Name Type Direction Description
message String OUT The wait state/error

state message to you.

out string[] buttonTexts

Name Type Direction Description
buttonTexts string array OUT An array of strings

containing the possible
response types that
you can send.

string response

Name Type Direction Description
response string IN A string containing the

response type that you
can select (it must be
one of the strings in the
string array
buttonTexts).

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

 TekExpress programmatic interface

TekExpress D-PHY Printable Application Help 201



After the test is complete Command name Parameters Description Return Value Example
GetPassFailStatu
s()

string clientID
string device
string suite
string test

This method gets
the pass or fail
status of the
measurement after
test completion.

NOTE. Execute
this command
after completing
the measurement.

String that gives
the status of the
operation after it
has been
performed.
Returns the pass
or fail status in the
form of a string.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.GetPassFailStatu
s(clientID, device,
suite, ”1.1.3 Data
Lane Rise
Time”) //Pass or
Fail

GetResultsValue() string clientID
string device
string suite
string test
string
parameterString

This method gets
the result values of
the measurement
after the run.

String that gives
the status of the
operation after it
has been
performed.
Returns the result
value in the form
of a string.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as srting
returnval=m_Clien
t.GetResultsValue(
clientID, "D-PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time",
"Measured Value")
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Command name Parameters Description Return Value Example
GetResultsValueF
orSubMeasureme
nts()

string clientID
string device
string suite
string test
string
parameterString
int rowNr

This method gets
the result values
for individual sub-
measurements,
after the run.

String that gives
the status of the
operation after it
has been
performed.
Returns the result
value in the form
of a string.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Data Lane Rise
Time DP (nS)
returnval=m_Clien
t.GetResultsValue
ForSubMeasurem
ents(clientID, "D-
PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time",
"1.1.3 Data Lane
Rise Time”,
"Measured Value",
0) //For DP wfm
returnval=m_Clien
t.GetResultsValue
ForSubMeasurem
ents(clientID, "D-
PHY",
"Transmitter",
"1.1.3 Data Lane
Rise Time",
"Measured Value",
1) //For DN wfm
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Command name Parameters Description Return Value Example
GetReportParamet
er()

string clientID
string device
string suite
string test
string
parameterString

This method gets
the general report
details such as
oscilloscope
model,
TekExpress
version, and D-
PHY version.

The return value is
the oscilloscope
model,
TekExpress
version, and D-
PHY version.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Oscilloscope
Model
returnval=m_Clien
t.GetReportParam
eter(clientID,"Scop
e Model")
TekExpress
Version
returnval=m_Clien
t.GetReportParam
eter(clientID,"TekE
xpress Version")
D-PHY Version
returnval=m_Clien
t.GetReportParam
eter(clientID,"Appli
cation Version")

TransferReport() string clientID
string filePath

This method
transfers the
report generated
after the run.
The report
contains the
summary of the
run.
The client must
provide the
location where the
report is to be
saved at the client-
end.

String that gives
the status of the
operation after it
has been
performed.
Transfers all the
result values in the
form of a string.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.TransferReport(cl
ientID,"C:\Report”)
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Command name Parameters Description Return Value Example
TransferWaveform
s()

string clientID
string filePath

This method
transfers all the
waveforms from
the folder for the
current run.

NOTE. For each
click of Run
button, a folder is
created in the X:
drive. Transfer the
waveforms before
clicking the Run
button.

String that gives
the status of the
operation after it
has been
performed.
Transfers all the
waveforms in the
form of a string.
On success the
return value is
“Transferred...”.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.TransferWavefor
ms(clientID,"C:
\Waveforms”)

TransferImages() string clientID
string filePath

This method
transfers all the
images
(screenshots) from
the folder for the
current run (for a
given suite or
measurement).

NOTE. For each
click of Run
button, a folder is
created in the X:
drive. Transfer the
waveforms before
clicking the Run
button.

String that gives
the status of the
operation after it
has been
performed.
Transfers all the
images in the form
of a string.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.TransferImages(c
lientID, "C:
\Waveforms”)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.
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string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.

int rowNr

Name Type Direction Description
rowNr int IN Specifies the zero

based row index of the
sub-measurement for
obtaining the result
value.

string filePath

Name Type Direction Description
filePath string IN The location where the

report must be saved in
the client.

NOTE. If the client does not provide the location to save the report, the report is
saved at C:\ProgramFiles.

string parameterString

Name Type Direction Description
parameterString string IN Specifies the

oscilloscope model,
TekExpress version,
and D-PHY version.
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Save, recall, or check if a
session is saved

Command name Parameters Description Return Value Example
CheckSessionSav
ed() 

string clientID
out bool saved

This method is
called when a
check is to be
made to know if
the current
session is saved.

Return value is
either True or
False.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.CheckSessionSa
ved(m_clientID,
out savedStatus)

RecallSession() string clientID
string name

Recalls a saved
session. The
name of the
session is
provided by the
client.

String that gives
the status of the
operation after it
has been
performed.
The return value is
“Session
Recalled...”.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.RecallSession(cli
entID,
savedSessionNam
e)

SaveSession() string clientID
string name

Saves the current
session. The
name of the
session is
provided by the
client.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"Session
Saved..."/"Failed...
".

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.SaveSession(clie
ntID,
desiredSessionNa
me)

SaveSessionAs() string clientID
string name

Saves the current
session in a
different name
every time this
method is called.
The name of the
session is
provided by the
client.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"Session
Saved...".

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.SaveSessionAs(c
lientID,
desiredSessionNa
me)
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out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string name

Name Type Direction Description
name string IN The name of the

session being recalled.

The name parameter cannot be empty. If it is empty, the client is prompted to
provide a valid name.

out bool saved

Name Type Direction Description
saved bool OUT Boolean representing

whether the current
session is saved.

This parameter is used as a check in SaveSession() and SaveSessionAs()
functions.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Unlock the server Command name Parameters Description Return Value Example
UnlockSession() string clientID This method

unlocks the server
from the client.
The ID of the client
to be unlocked
must be provided.
Note

NOTE. When the
client is
disconnected, it is
unlocked from the
server and then
disconnected. The
id is reused.

String that gives
the status of the
operation after it
has been
performed.
The return value is
"Session Un-
Locked...".

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.UnlockServer(clie
ntID)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

TekExpress programmatic interface  

210  TekExpress D-PHY Printable Application Help



Disconnect from the
server

Command name Parameters Description Return Value Example
Disconnect() string clientID This method

disconnects the
client from the
server it is
connected to. Note

NOTE. When the
client is
disconnected, it is
unlocked from the
server and then
disconnected. The
id is reused.

Integer value that
gives the status of
the operation after
it has been
performed.
1 for Success
–1 for Failure

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
returnval=m_Clien
t.Disconnect(m_cli
entID)

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Select a lane Command name Parameters Description Return Value Example
SetGeneralParam
eter() 

string clientID
string device
string suite
string test
string
parameterString

This method sets
the parameters
that are not
specific to any
given test.
Note. Using this
command you can
select a lane,
channel, or source
type.

String that gives
the status of the
operation after it
has been
performed.
The return value
is ” (an empty
string) on success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Select/Deselect a
Lane
Deselect a Lane

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.
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NOTE. To select Lane 1, the parameterString is “Lane1:Lane 1$Included”, To
deselect it – “Lane1:Lane 1$Excluded”

To select Lane 2, the parameterString is “Lane2:Lane 1$Included”, To deselect
it – “Lane2:Lane 1$Excluded”

To select Lane 3, the parameterString is “Lane3:Lane 1$Included”, To deselect
it – “Lane3:Lane 1$Excluded”

To select Lane 4, the parameterString is “Lane4:Lane 1$Included”, To deselect
it – “Lane4:Lane 1$Excluded”

Example:returnval=mClient.SetGeneralParameter(clientID,”D-
PHY”,”Transmitter”, “1.1.3 Data Lane Rise Time”, “Lane1:Lane 1$Included”)

Assign input signals to
scope channels

Command name Parameters Description Return Value Example
SetGeneralParam
eter() 

string clientID
string device
string suite
string test
string
parameterString

This method sets
the parameters
that are not
specific to any
given test.
Note. Using this
command you can
select a lane,
channel, or source
type.

String that gives
the status of the
operation after it
has been
performed.
The return value is
" ” (an empty
string) on success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Assign input
signals to scope
channels

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.
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string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.

NOTE. To assign the Dp signal to Channel 1, the parameterString is “Lane5
Connected to:Data:Dn$CH1”

To assign the Dp signal to Channel 1, the parameterString is “Lane6 Connected
to:Data:Dn$CH1”

To assign the Clkpp signal to Channel 1, the parameterString is “Lane7
Connected to:Clock:Clkp$CH1”

To assign the Clknn signal to Channel 1, the parameterString is “Lane8
Connected to:Clock:Clkn$CH1”

To assign the Clkp-Clkn signal to channel 1 if a differential probe is used for the
clock signals, the parameterStrign is “Lane9 Connected to:Clkp-clkn$CH1”

You can assign the signal to CH1, CH2, CH3, or CH4. These values must replace
the text after the ‘$’ symbol in parameterString.

Example:returnval=mClient.SetGeneralParameter(clientID,”D-
PHY”,”Transmitter”, “1.1.3 Data Lane Rise Time”, “Lane5 Connected
to:Data:Dn$CH1”)
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Assign each lane input
signal to RF switch ports

Command name Parameters Description Return Value Example
SetGeneralParam
eter() 

string clientID
string device
string suite
string test
string
parameterString

This method sets
the parameters
that are not
specific to any
given test.
Note. Using this
command you can
select a lane,
channel, or source
type.

String that gives
the status of the
operation after it
has been
performed.
The return value is
" ” (an empty
string) on success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Assign data lane
input signals to RF
switch ports
Assign clock lane
input signals to RF
switch ports

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.
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NOTE. To assign the data lane input signals to RF switch ports

To assign each lane’s DP/DN signals to ports, parameterString format is
“<LaneName> <DataSignalName> Connected to$<PortName>”

<LaneName> can have one of the following values — Lane1, Lane2, Lane3, or
Lane4

DataSignalName> can have one of the following values — DP or DN

PortName> can have one of the following vallues — Port 1, Port 2, Port 3, or
Port 4 

For example,;

To assign Lane 1 DP signal to Port 1, the parameterString is “Lane1 DP
Connected to$Port 1”

Example:returnval=mClient.SetGeneralParameter(clientID,”D-
PHY”,”Transmitter”, “1.1.3 Data Lane Rise Time”, “Lane1 DP Connected to
$Port 1”)

To assign clock lane input signals to RF switch ports

To Assign CP/CN signal to ports, parameterString format is
“<ClockSignalName> Connected to$<PortName>”

<ClockSignalName> can have one of the following values — CP or CN

<PortName> can have one of the following values — Port 1, Port 2, Port3, or
Port 4 

For example:

To assign CP signal to Port 1, the parameterString is “CP Connected to$Port1”

Example:

retrunval=mClient.SetGeneralParameter(clientID, “D-PHY”, “Transmitter”,
“1.1.3 Data Lane Rise Time”, “CP Connected to$Port 1”)
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Enable-Disable
automation of the lane

switching with RF switch

Command name Parameters Description Return Value Example
SetGeneralParam
eter() 

string clientID
string device
string suite
string test
string
parameterString

This method sets
the parameters
that are not
specific to any
given test.
Note. Using this
command you can
select a lane,
channel, or source
type.

String that gives
the status of the
operation after it
has been
performed.
The return value is
" ” (an empty
string) on success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Enable/Disable
automation of htte
lane switching with
an RF switch

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client

that is connected to the
server.
clientId = unique
number + ipaddress of
the client. For example,
1065–192.157.98.70 

string device

Name Type Direction Description
device string IN Specifies the name of

the device.

string suite

Name Type Direction Description
suite string IN Specifies the name of

the suite.

string test

Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a

test.
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NOTE. To enable the automation of lane switching, the parameterString is
“Automate with RF Switch$True”

To disable the automation of lane switching, the parameterString is “Automate
with RF Switch$False”

Example:returnval=mClient.SetGeneralParameter(clientID,”D-
PHY”,”Transmitter”, “1.1.3 Data Lane Rise Time”, “Automate with RF Switch
$True”)

Handle error codes The return value of the remote automations at the server-end is OP_STATUS
which is changed to a string value depending on its code and returned to the
client. The values of OP_STATUS are as follows:

Value Code Description
FAIL −1 The operation failed.
SUCCESS 1 The operation succeeded.
NOTFOUND 2 Server not found
LOCKED 3 The server is locked by another

client, so operation cannot be
performed.

UNLOCK 4 The server is not locked. Lock
the server before performing
the operation.

NULL 0 Nothing
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Program example
This program example shows how to communicate between a PC and
TekExpress D-PHY remotely.

A typical application does the following:

1. Start the application.

2. Connect through an IP address.

m_Client.Connect("localhost") 'True or False

clientID = m_Client.getClientID

3. Lock the server.

m_Client.LockServer(clientID)

4. Disable the Popups.

m_Client.SetVerboseMode(clientID, false)

5. Set the Dut ID.

m_Client.SetDutId(clientID, "DUT_Name")

6. Select a measurement.

mClient.SelectTest(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", true) 'Data Lane Rise Time measurement selected

7. Select a channel.

mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Data + Signal connected to Real Time Scope at$Channel
1") Data Lane Rise Time measurement selected

8. Configure the selected measurement.

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger Type$Transition") 'Data Lane Rise Time
measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger Source$Ch1") 'Data Lane Rise Time
measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger Upper Level(V)$1") 'Data Lane Rise Time
measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger Lower Level(V)$0") 'Data Lane Rise Time
measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger Time(pS)$500") 'Data Lane Rise Time
measurement selected
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mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger Transition$Greater Than") 'Data Lane Rise Time
measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger Slope$Positive") 'Data Lane Rise Time
measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data
Lane Rise Time", "Trigger If Violation$Occurs") 'Data Lane Rise Time
measurement selected

9. Run with set configurations.

m_Client.Run(clientID)

10. Wait for the test to complete.

Do

Thread.Sleep(500)

m_Client.Application_Status(clientID)

Select Case status

Case "Wait"

'Get the Current State Information

mClient.GetCurrentStateInfo(clientID, WaitingMsbBxCaption,
WaitingMsbBxMessage, WaitingMsbBxButtontexts)

'Send the Response

mClient.SendResponse(clientID, WaitingMsbBxCaption,
WaitingMsbBxMessage, WaitingMsbBxResponse)

End Select

Loop Until status = "Ready"

11. After the Test is Complete.

'Save all results values from folder for current run

m_Client.TransferResult(clientID, logDirname)

'Save all waveforms from folder for current run

m_Client.TransferWaveforms(clientID, logDirname)

'Save all images from folder for current run

m_Client.TransferImages(clientID, logDirname)

12. Unlock the server.

m_Client.UnlockServer(clientID)

13. Disconnect from server.
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m_Client.Disconnect()

14. Exit the application.

NI TestStand Client
example

The following is an example for NI TestStand Client available in the path, C:
\Program Files\Tektronix\TekExpress\TekExpress D-PHY\Examples
\Programmatic Interface\TestStand
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Reference

Algorithms

Group 1 tests Test 1.1.1 Data Lane LP-TX Thevenin Output High Level Voltage (VOH). Data Lane
LP-TX Thevenin Output High Level Voltage is calculated using the following
algorithm: 

■ Acquire the Dp and Dn waveforms by setting the transition trigger from LP
to HS mode (LP11-10) on the oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Dp waveform and find the LP signaling sequence.
■ In the LP sequence region, find the absolute peak-to-peak value. VOH is

measured as the mode of all the waveform samples greater than 50% of
the absolute peak-to-peak.

where,

Dp – Data positive waveform

Dn – Data negative waveform
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Test 1.1.2 Data Lane LP-TX Thevenin Output Low Level Voltage (VOL). Data Lane
LP-TX Thevenin Output Low Level Voltage is calculated using the following
algorithm: 

■ Acquire the Dp and Dn waveforms by setting the transition trigger from LP
to HS mode (LP11-10) on the oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Dp waveform and find the LP signaling sequence.
■ In the LP sequence region, find the absolute peak-to-peak value. VOL is

measured as the mode of all the waveform samples lower than 50% of
the absolute peak-to-peak.

where,

Dp – Data positive waveform

Dn – Data negative waveform
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Test 1.1.3 Data Lane Rise Time. Data Lane Rise Time is calculated using the
following algorithm: 

■ Acquire the Dp and Dn waveforms by setting the transition trigger from LP
to HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Dp waveform and find the LP signaling sequence.
■ In the LP sequence region, find the absolute peak-to-peak. VOH is

measured as the mode of all the waveform samples greater than 50% of
the absolute peak-to-peak and VOL is measured as the mode of all the
waveform samples lower than 50% of the absolute peak-to-peak.

■ Find all the rising edges in the Dp waveform and find the 15%-85% rise
time with reference to VOL and VOH for each of the edges and average
the results. This result is Rise Time (TRLP).

where,

Dp – Data positive waveform

Dn – Data negative waveform
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Test 1.1.4 Data Lane Fall Time. Data Lane Fall Time is calculated using the
following algorithm: 

■ Acquire the Dp and Dn waveforms by setting the transition trigger from LP
to HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Dp waveform and find the LP signaling sequence.
■ In the LP sequence region, find the absolute peak-to-peak. VOH is

measured as the mode of all the waveform samples greater than 50% of
the absolute peak-to-peak and VOL is measured as the mode of all the
waveform samples lower than 50% of the absolute peak-to-peak..

■ Find all the falling edges in the Dp waveform and find the 15%-85% fall
time with reference to VOL and VOH for each of the edges and average
the results. This result is Fall Time (TFLP).

where,

Dp – Data positive waveform

Dn – Data negative waveform
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Test 1.1.5 Data Lane LP-TX Slew Rate Versus CLOAD (ōV/ōtSR). Data Lane LP-TX
Slew Rate Versus CLOAD is calculated using the following algorithm: 

■ Acquire the Dp and Dn waveforms by setting the transition trigger from LP
to HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400-MHz, 4th-order Butterworth
lowpass test filter is applied to the source waveform.

■ Determine the max and min for the Dp and Dn waveforms.
■ Find all the falling edges in the Dp waveform.
■ Find the slew rate for each falling edge of Dp from maxDp to minDp

with a vertical window of 50 mV.
■ Find the maximum slew rate, maxSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Dp.
■ Find the mean of maxSR(i), where maxFallSRDp=mean(maxSR(i)).
■ Find all the falling edges in the Dn waveform.
■ Find the slew rate for each falling edge of Dn from maxDn to minDn

with a vertical window of 50 mV.
■ Find the maximum slew rate, maxSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Dn.
■ Find the mean of maxSR(i), where maxFallSRDn = mean(maxSR(i)).
■ Find all the falling edges in the Dp waveform.
■ Find the slew rate for each falling edge of Dp from 0.93 V to 0.4 V with

a vertical window of 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Dp.
■ Find the mean of minSR(i), where minFallSRDp = mean(minSR(i)).
■ Find all the falling edges in the Dn waveform.
■ Find the slew rate for each falling edge of Dn from 0.93 V to 0.4 V with

a vertical window of 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Dn.
■ Find the mean of minSR(i), where minFallSRDn = mean(minSR(i)).
■ Find the rising edges of Dp.
■ Find the slew rate for each rising edge of Dp from minDp to maxDp with

a vertical window of 50 mV.
■ Find the maximum slew rate, maxSR(i), where i represents the rising

edge number. Repeat this step for each rising edge of Dp.
■ Find the mean of maxSR(i), where maxRiseSRDp = mean(maxSR(i)).
■ Find all the rising edges in the Dn waveform.
■ Find the slew rate for each rising edge of Dn from minDn to maxDn with

a vertical window of 50 mV.
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■ Find the maximum slew rate, maxSR(i), where i represents the rising
edge number. Repeat this step for each rising edge of Dn.

■ Find the mean of maxSR(i), where maxRiseSRDn = mean(maxSR(i)).
■ Find all the rising edges in the Dp waveform.
■ Find the slew rate for each rising edge of Dp from 0.4 V to 0.7 V with a

vertical window of 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the rising edge

number. Repeat this step for each rising edge of Dp.
■ Find the mean of minSR(i), where minRiseSRDp = mean(minSR(i)).
■ Find all the rising edges in the Dn waveform.
■ Find the slew rate for each rising edge of Dn from 0.4 V to 0.7 V with a

vertical window of 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the rising edge

number. Repeat this step for each falling edge of Dn.
■ Find the mean of minSR(i), where minRiseSRDn = mean(minSR(i)).
■ Find all the rising edges in the Dp waveform.
■ Find the slew rate for each rising edge of Dp from 0.7 V to 0.93 V with a

vertical window of 50 mV.
■ Find the minimum slew rate margin, minSRMargin(i), where i represents

the rising edge number. Repeat this step for each rising edge of Dp.
■ Find the mean of minSRMargin(i), where minRiseSRMarginDp =

mean(minSRMargin(i)).
■ Find all the rising edges in the Dn waveform.
■ Find the slew rate for each rising edge of Dn from 0.7 V to 0.93 V with a

vertical window of 50 mV.
■ Find the minimum slew rate margin, minSRMargin(i), where i represents

the rising edge number. Repeat this step for each rising edge of Dn.
■ Find the mean of minSRMargin(i), where minRiseSRMarginDn =

mean(minSRMargin(i)).

where,

Dp – Data positive waveform

Dn – Data negative waveform

Reference  
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Test 1.1.6 Data Lane LP-TX Pulse Width of Exclusive-OR Clock (TLP-PULSE-TX).
Data Lane LP-TX Pulse Width of Exclusive-OR Clock is calculated using the
following algorithm: 

■ Acquire the Dp and Dn waveforms by setting the transition trigger from LP
to HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Find edges (edge positions) of Dp and Dn(MREF = 0.93/0.5 V and
HYSTREF = 0.05 V).

■ Quantize (2-level, 1 and 0) Dp and Dn with all points between a rising
edge and a falling edge set to 1 and all points between a falling edge and
rising edge set to 0. Bit XOR the quantized Dp and Dn to get the low
power clock.

■ Find edges (edge positions) of the low power clock (MPCT = 50%,
HYSTPCT = 0%). Filter out transients (due to noise) in the set of
computed edge positions.

■ Find the positive pulse width (between rising and falling edges).
■ Find the minimum of all pulse widths excluding first and last pulse with.

where,

Dp – Data positive waveform

Dn – Data negative waveform

 Reference
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Test 1.1.7 Data Lane LP-TX Period of Exclusive-OR Clock (TLP-PER-TX). Data Lane
LP-TX Period of Exclusive-OR Clock is calculated using the following
algorithm: 

■ Acquire the Dp and Dn waveforms by setting the transition trigger from LP
to HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Find the edges (edge positions) of Dp and Dn (MREF = 0.93/0.5 V and
HYSTREF = 0.05 V).

■ Quantize (2-level, 1 and 0) Dp and Dn with all points between a rising
edge and a falling edge set to 1 and all points between a falling edge and
rising edge set to 0. Bit XOR the quantized Dp and Dn to get the low
power clock.

■ Find edges (edge positions) of the low power clock. Filter out transients
(due to noise) in the set of computed edge positions.

■ Find the rise to rise period (between two rising edges).
■ Find the minimum of all pulse widths excluding first and last pulse with.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Group 2 tests Test 1.2.1 Clock Lane LP-TX Thevenin Output High Level Voltage (VOH). Clock
Lane LP-TX Thevenin Output High Level Voltage is calculated using the
following algorithm: 

■ Acquire the Cp and Cn waveforms by setting the transition trigger from LP to
HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Cp waveform and find the LP signaling sequence.
■ In the LP-11 sequence region, find the absolute peak-to-peak. VOH is

measured as the mode of all the waveform samples greater than 50% of
the absolute peak-to-peak.

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Reference  
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Test 1.2.2 Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL). Clock Lane
LP-TX Thevenin Output Low Level Voltage is calculated using the following
algorithm: 

■ Acquire the Cp and Cn waveforms by setting the transition trigger from LP to
HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Cp waveform and find the LP signaling sequence.
■ In the LP-00 sequence region, find the absolute peak-to-peak. VOL is

measured as the mode of all the waveform samples lower than 50% of
the absolute peak-to-peak.

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.2.3 Clock Lane Rise Time. Clock Lane Rise Time is calculated using the
following algorithm: 

■ Acquire the Cp and Cn waveforms by setting the transition trigger from LP to
HS mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Cp waveform and find the LP signaling sequence.
■ In the LP sequence region, find the absolute peak-to-peak and VOH is

measured as the mode of all the waveform samples greater than 50% of
the absolute peak-to-peak and VOL is measured as the mode of all the
waveform samples lower than 50% of the absolute peak-to-peak.

■ Find all the rising edges in the Cp waveform and find the 15%-85% rise
time with reference to VOL and VOH for each of the edges and average
the results. This result is Rise Time (TRLP).

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

 Reference
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Test 1.2.4 Clock Lane Fall Time. Clock Lane Fall Time is calculated using the
following algorithm: 

■ Acquire Cp and Cn waveform by setting the Transition trigger from LP to HS
mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Traverse the Cp waveform and find the LP signaling sequence.
■ In the LP sequence region, find the absolute peak-to-peak and VOH is

measured as the mode of all the waveform samples greater than 50% of
the absolute peak-to-peak and VOL is measured as the mode of all the
waveform samples lower than 50% of the absolute peak-to-peak.

■ Find all the falling edges in the Cp waveform and find the 15%-85% fall
time with reference to VOL and VOH for each of the edges and average
the results. This result is Fall Time (TFLP).

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Reference  
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Test 1.2.5 Clock Lane LP-TX Slew Rate Versus CLOAD (ōV/ōtSR). Clock Lane LP-
TX Slew Rate Versus CLOAD is calculated using the following algorithm: 

■ Acquire Cp and Cn waveform by setting the Transition trigger from LP to HS
mode (LP11-10) on oscilloscope.

■ Using post processing:

■ To reduce measurement noise, a 400 MHz, 4th order Butterworth
lowpass test filter is applied to the source waveform.

■ Find the maximum and minimum of the Cp and Cn waveforms.
■ Find the falling edges of Cp.
■ Find the slew rate for each falling edge of Cp from maxCp to MinCp

with the vertical window at 50 mV.
■ Find the maximum slew rate, maxSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Cp.
■ Find the mean of maxSR(i), where maxFallSRCp = mean(maxSR(i)).
■ Find the falling edges of Cn.
■ Find the slew rate for each falling edge of Cn from maxCn to MinCn

with the vertical window at 50 mV.
■ Find the maximum slew rate, maxSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Cn.
■ Find the mean of maxSR(i), where maxFallSRCn = mean(maxSR(i)).
■ Find the falling edges of Cp.
■ Find the slew rate for each falling edge of Cp from 0.93 V to 0.4 V with

the vertical window at 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Cp.
■ Find the mean of minSR(i), where maxFallSRCp = mean(minSR(i)).
■ Find the falling edges of Cn.
■ Find the slew rate for each falling edge of Cn from 0.93 V to 0.4 V with

the vertical window at 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the falling

edge number. Repeat this step for each falling edge of Cn.
■ Find the mean of minSR(i), where minFallSRCn = mean(minSR(i)).
■ Find the rising edges of Cp.
■ Find the slew rate for each rising edge of Cp from minCp to MaxCp with

the vertical window at 50 mV.
■ Find the maximum slew rate, maxSR(i), where i represents the rising

edge number. Repeat this step for each rising edge of Cp.
■ Find the mean of maxSR(i), where maxRiseSRCp = mean(maxSR(i)).
■ Find the rising edges of Cn.
■ Find the slew rate for each rising edge of Cn from minCn to MaxCn with

the vertical window at 50 mV.

 Reference
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■ Find the maximum slew rate, maxSR(i), where i represents the rising
edge number. Repeat this step for each rising edge of Cn.

■ Find the mean of maxSR(i), where maxRiseSRCn = mean(maxSR(i)).
■ Find the rising edges of Cp.
■ Find the slew rate for each rising edge of Cp from 0.4 V to 0.7 V with the

vertical window at 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the rising edge

number. Repeat this step for each rising edge of Cp.
■ Find the mean of minSR(i), where minRiseSRCp = mean(minSR(i)).
■ Find the rising edges of Cn.
■ Find the slew rate for each rising edge of Cn from 0.4 V to 0.7 V with the

vertical window at 50 mV.
■ Find the minimum slew rate, minSR(i), where i represents the rising edge

number. Repeat this step for each rising edge of Cn.
■ Find the mean of minSR(i), where minRiseSRCn = mean(minSR(i)).
■ Find the rising edges of Cp.
■ Find the slew rate for each rising edge of Cp from 0.7 V to 0.93 V with

the vertical window at 50 mV.
■ Find the minimum slew rate margin, minSRMargin(i), where i represents

the rising edge number. Repeat this step for each rising edge of Cp.
■ Find the mean of minSRMargin(i), where minRiseSRMarginCp =

mean(minSR(i)).
■ Find the rising edges of Cn.
■ Find the slew rate for each rising edge of Cn from 0.7 V to 0.93 V with

the vertical window at 50 mV.
■ Find the minimum slew rate margin, minSRMargin(i), where i represents

the rising edge number. Repeat this step for each rising edge of Cn.
■ Find the mean of minSRMargin(i), where minRiseSRMarginCn =

mean(minSR(i)).

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Reference  
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Group 3 tests Test 1.3.1 Data Lane HS Entry: Data Lane TLPX Value. Data Lane TLPX Value is
calculated using the following algorithm: 

■ Acquire Dp and Dn waveform by setting the Transition trigger from LP to
HS mode (LP11-10) on oscilloscope.

■ Using post processing, traverse the Dp waveform and find the Cursor 1 and
Cursor 2 positions corresponding to LP-01 signaling sequence as given:

■ Compute Dp–Dn and look for points with voltage greater than 550 mV.
If the number of points found is 0, then compute Dn–Dp and look for
points with voltage greater than 550 mV. If the number of points found is
0, then the signal is not correct. If the signal is correct, proceed with the
following steps on the difference signal (Diff):

■ In the Diff waveform, in the region corresponding to the LP signaling
sequence region, find the first rising edge and successive falling
edge.

■ The time difference between these two edges at voltage level of
550 mV is TLPX.

■ where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

 

 

 Reference
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Test 1.3.2 Data Lane HS Entry: THS-PREPARE Value. Data Lane THS-PREPARE
Value is calculated using the following algorithm: 
■ Acquire Dp and Dn waveform by setting the Transition trigger from LP to

HS mode (LP11-10) on the oscilloscope.
■ Using post processing, traverse the Dp waveform and find the Cursor2 and

Cursor3 positions corresponding to LP-00 signaling sequence as given
below:
■ Subtract the Dp and Dn waveforms to obtain Dp-Dn.
■ In the LP signaling sequence, in Dp–Dn find the first rising edge and

successive falling edge. Cursor 2 is the point where the falling edge
touches 550 mV.

■ Compute VOLHS:
■ Find the high speed sequence in the input waveform.
■ Find the highest and the lowest voltage values in the high speed

sequence. The mode of all the values greater than 50% of the peak-to-
peak is the VOHHSand the mode of all the values less than 50% of the
peak-to peak is the VOLHS.

■ Find the Cursor 3 position:
■ From the point corresponding to Cursor 2 on Dn, traverse to the right of

the Dn waveform and find a point that is less than or equal to the VOLHS.
Mark this point as Marker 1.

■ From Marker 1, traverse both the Dn and Dp waveforms and find the first
point which is greater than or equal to VOHHS on either of Dn or Dp
waveforms. Mark this point as Marker 2.

■ On the waveform where the Marker 2 point was found, traverse to the
left of the waveform until a point less than or equal to 70 mV is located.
This is Cursor 3.

■ The time between Cursor 3 and Cursor 2 is THS-PREPARE.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform
 

Reference  
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Test 1.3.3 Data Lane HS Entry: THS-PREPARE + THS-ZERO Value. Data Lane THS-
PREPARE + THS-ZERO Value is calculated using the following algorithm: 

■ Acquire Dp and Dn waveform by setting the Transition trigger from LP to
HS mode (LP11-10) on the oscilloscope.

■ Using post processing, traverse the Dp waveform and find the Cursor 2 and
Cursor 4 positions as below:

■ Subtract the Dp and Dn waveforms to obtain Dp–Dn.
■ In the LP signaling sequence, in Dp–Dn find the first rising edge and

successive falling edge. Marker 1 is the point where the falling edge
touches 550 mV. Cursor 2 = Marker 1.

■ Compute VOLHS:

■ Find the high speed sequence in the input data waveforms.
■ Find the highest and the lowest voltage values in the high speed

sequence. The mode of all the values greater than 50% of the peak-to-
peak is the VOHHS and the mode of all the values less than 50% of the
peak-to peak is the VOLHS.

■ Find the Cursor 4 position.

■ From the point corresponding to Marker 1 on Dn, traverse to the right of
Dn waveform and find a point that is less than or equal to the VOLHS.
Mark this point as Marker 2.

■ From Marker 2, traverse both the Dn and Dp waveforms and find the first
point which is greater than or equal to VOHHS on either of Dn or Dp
waveforms. Mark this point as Marker 3.

■ On the waveform where the Marker 3 point was found, traverse to the
left of the waveform until a point less than or equal to 70 mV is located.
This is Marker 4.

■ On the waveform where the point corresponding to Marker 3 was found,
traverse to the right and find a point where the voltage is less than or
equal to (VOHHS +VOLHS)/2. This is Marker 5.

■ Starting from Marker 5, on the same waveform where the point
corresponding to Marker 5 was found, traverse further and find a point
where the voltage is greater than or equal to (VOHHS +VOLHS)/2. This is
Marker 6. Marker 5–Marker 6 is almost 1High speed UI. Hence
Marker 5–3*(Marker 6–Marker 5) is the end point of THS-ZERO. Call this
Marker 7.

■ THS-ZERO is the time between Marker 7 and Marker 4.
■ Cursor 4 = Marker 7 

■ The time between Cursor 2 and Cursor 4 is THS-PREPARE + TZERO.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Reference  
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Test 1.3.4 Data Lane HS-TX Differential Voltages (VOD(0), VOD(1)). Data Lane HS-
TX Differential Voltages (VOD(0), VOD(1)) is calculated using the following
algorithm: 

NOTE. In the Manual Method, the measurement must be performed on a
differential signal Instead of a single-ended signal.

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and
the sampling rate of the waveform.

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify all the HS regions in the input data waveforms.
■ In the HS regions of the input data waveforms, identify a ‘100000’ pattern to

measure VOD(0) and identify a ‘011111’ pattern to measure VOD(1)
(00000 or 11111 is a region with about 5 UI interval length).

■ Measure VOD(0) and VOD(1) values as the mean of all voltage samples
between the centers of fourth and fifth 0/1 bit respectively.

■ Average VOD(0) and VOD(1) across all instances of the pattern

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

 Reference
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Test 1.3.5 Data Lane HS-TX Differential Voltage Mismatch (VOD). Data Lane HS-TX
Differential Voltage Mismatch (VOD) is calculated using the following
algorithm: 

NOTE. In the Manual Method, the measurement must be performed on a
differential signal Instead of a single-ended signal.

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and
the sampling rate of the waveform.

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify all the HS regions in the input data waveforms.
■ In the HS regions of the input data waveforms, identify a ‘100000’ pattern to

measure VOD(0) and identify a ‘011111’ pattern to measure VOD(1)
(00000 or 11111 is a region with about 5 UI interval length).

■ Measure VOD(0) and VOD(1) values as the mean of all voltage samples
between the centers of fourth and fifth 0/1 bit respectively.

■ Average VOD(0) and VOD(1) across all instances of the pattern
■ Compute ΔVOD = |VOD(1)| - |VOD(0)|

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.3.6 Data Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP),
VOHHS(DN)). Data Lane HS-TX Single-Ended Output High Voltages
(VOHHS(DP), VOHHS(DN)) is calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and
the sampling rate of the waveform.

■ Identify all the HS regions in the input clock waveforms and estimate the UI.
■ Identify all the HS regions in the input data waveforms.
■ In the HS regions of the input data waveforms, identify a 011111 pattern on

Dp and Dn to measure VOHHS(Dp) and VOHHS(Dn) respectively (11111 is
a region with about 5 UI interval length).

■ Calculate VOHHS(Dp) and VOHHS(Dn) as the measured mean of all
voltage samples between the centers of the 4th and 5th 1 bit respectively.

■ Average VOHHS(Dp) and VOHHS(Dn) across all instances of the pattern.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Reference  
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Test 1.3.7 Data Lane HS-TX Static Common Mode Voltages (VCMTX(0), VCVMTX(1)).
Data Lane HS-TX Static Common Mode Voltages (VCMTX(0), VCVMTX(1))
is calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and
the sampling rate of the waveform.

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Create an VCMTX waveform as VCMTXX = (Dp + Dn)/2.
■ Identify all the HS regions in the input data and VCMTX waveforms.
■ At the Mid-point of each Clock UI, check if the data is at Differential-0 or

Differential-1 state.
■ Obtain the corresponding point on the VCMTXX waveform. If the data is

Differential-0, the point is added to VCMTX(0), else if the data is
Differential-1, the point added to VCMTX(1).

■ Average all values of VCMTX(0) and VCMTX(1).

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.3.8 Data Lane HS-TX Static Common-Mode Voltage Mismatch (ΔVCMTX(1,0)).
Data Lane HS-TX Static Common-Mode Voltage Mismatch (ΔVCMTX(1,0)) is
calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and
the waveform.

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Create an VCMTX waveform as VCMTX = (Dp + Dn)/2.
■ Identify all the HS regions in the input data and VCMTX waveforms.
■ At the mid-point of each Clock UI, check if the data is at Differential-0 or

Differential-1 state.
■ Obtain the corresponding point on the VCMTX waveform. If the data is

Differential-0, the point is added to VCMTX(0), else if the data is
Differential-1, the point added to VCMTX(1).

■ Average all values of VCMTX(0) and VCMTX(1) and calculate ∆CMTX(1,0) =
(VCMTX (1) – VCMTX (0))/2.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform
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Test 1.3.9 Data Lane HS-TX Dynamic Common-Level Variations Between
50-450MHz . Data Lane HS-TX Dynamic Common-Level Variations Between
50-450MHz is calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Bandpass Filtered Data Lane signals
FilteredDp and FilteredDn, and the sampling rate.

■ Identify all the HS regions in the Filtered input data waveforms using
Unfiltered Dp and Dn.

■ Find the minimum voltage in the filtered data HS region, Vmin. Find the
maximum voltage in the Filtered data HS region, Vmax

■ Compute Vpeak as, Vpeak = max (Vmax, abs(Vmin))

where,

Dp – Data positive waveform

Dn – Data negative waveform

FilteredDp – Bandpass Filtered Data positive waveform

FilteredDn – Bandpass Filtered Data negative waveform

Test 1.3.10 Data Lane HS-TX Dynamic Common-Level Variations Above 450MHz .
Data Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz is
calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Bandpass Filtered Data Lane signals
FilteredDp and FilteredDn, and the sampling rate.

■ Identify all the HS regions in the Filtered input data waveforms using
Unfiltered Dp and Dn.

■ Find the minimum voltage in the filtered data HS region, Vmin. Find the
maximum voltage in the Filtered data HS region, Vmax

■ Compute Vrms as:
 

 

where,

Dp – Data positive waveform

Dn – Data negative waveform

FilteredDp – Bandpass Filtered Data positive waveform

FilteredDn – Bandpass Filtered Data negative waveform

Reference  
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Test 1.3.11 Data Lane HS-TX 20%-80% Rise Time (tR). Data Lane HS-TX 20%-80%
Rise Time (tR) is calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and
the sampling rate of the waveform.

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify all the HS regions in the input data waveforms.
■ Compute VOD(0) and VOD(1).
■ In the HS regions of the input data waveforms identify a ‘000111’ pattern

(000 or 111 is a region with about 3 UI interval length).
■ Measure Rise-time, tR (as time between 20%-80% of the VOD), on the

identified ‘000111’ pattern.
■ Average all values of tR.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.3.12 Data Lane HS-TX 80%-20% Fall Time (tF). Data Lane HS-TX 80%-20%
Fall Time (tF) is calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and
the sampling rate of the waveform.

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify all the HS regions in the input data waveforms.
■ Compute VOD(0) and VOD(1).
■ In the HS regions of the input data waveforms identify a ‘111000’ pattern

(000 or 111 is a region with about 3 UI interval length).
■ Measure Fall-time, tF (as time between 80%-20% of the VOD), on the

identified ‘111000’ pattern.
■ Average all values of tF.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

 Reference
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Test 1.3.13 Data Lane HS Exit: THS-TRAIL Value. Data Lane HS Exit: THS-TRAIL
Value is calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn, Clock Lane signals Clkp and
Clkn(single-ended) or Clkp(differential, Clkp – Clkn).

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify the LP regions using input data waveform. Let the number of LP

regions be N.
■ From the beginning of every LP region, move backward in the waveform

until the absolute diff(Dp-Dn) is greater than 0.1v. Let these points be p(i),
i=0 to (N-1).

From p(i), move forward in waveform until the absolute value of the diff(Dp-
Dn) is less than 0.07v. Let these points be q(i). q(i) marks the end of trail
region.

■ From p(i) move backward in waveform until the point where single-ended
signals Dp and Dn cross each other. Let this point be r(i). r(i) marks the start
of trail region.

Trail_Duration(i) = [p(i) – r(i)]
■ Compute the mean of trail durations observed at all HS to LP transitions.

TrailMean = (1/N)*(Sum(Trail_Duration(i))

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.3.14 Data Lane HS Exit: 30%-85% Post-EOT Rise Time (TREOT). Data Lane
HS Exit: 30%-85% Post-EOT Rise Time (TREOT) is calculated using the
following algorithm: 

■ Acquire Data Lane signals Dp and Dn.
■ Identify the LP regions using input data waveform. Let the number of LP

regions be N.
■ From the beginning of every LP region, move backward in the waveform

until the absolute diff(Dp-Dn) is greater than 0.1v. Let the point be p(i),
i=0 to (N-1). From p(i), move forward in waveform until the absolute value
of the diff(Dp-Dn) is less than 0.07v. Let this point be q(i). q(i) marks the
start of TREOT region.

■ From q(i), move forward in waveform until the point where amplitude of
single-ended signal Dp goes greater than 0.88 volts. Let this point be r(i). r(i)
marks the end of TREOT region.

TREOT_Duration(i) = [r(i) – q(i)]
■ Compute the mean of TREOT durations observed at all HS to LP transitions.

Reference  
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Test 1.3.15 Data Lane HS Exit: TEOT Value. Data Lane HS Exit: TEOT Value is
calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn.
■ Acquire Clock Lane signals Cp and Cn.
■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Find the Ths-Trail as in Test 1.3.13.
■ Find Treot as in Test 1.3.14.
■ Compute Treot as TEOT = Ths-Trail + Treot..

Test 1.3.16 Data Lane HS Exit: THS-EXIT Value. Data Lane HS Exit: THS-EXIT
Value is calculated using the following algorithm: 

■ Acquire Data Lane signals Dp and Dn.
■ Identify the LP regions using input data waveform.
■ Mark the beginning of every LP region (corresponds to the end of Ths-Trail)

as the Start cursor.
■ Mark the End cursor at the point where the Dp or Dn (whichever is first)

falling edge goes below 550 mV.
■ Compute Ths-Exit as, THS-EXIT = End cursor – Start cursor.

Group 4 tests Test 1.4.1 Clock Lane HS Entry: TLPX Value. Clock Lane HS Entry: TLPX Value is
calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

■ Obtain a differential clock signal as CnMinCp = Cn - Cp
■ Find the Low Speed UI, LS_UI (for Low Power region).
■ Identify a rising edge in the CnMinCp waveform and its corresponding fall

edge (the rising and falling edges are taken corresponding to 0.55 V limit)
■ Identify a point on the Cp waveform corresponding to the rising edge on

CnMinCp. Mark this as Cursor1.
■ Identify a point on the Cn waveform corresponding to the falling edge on

CnMinCp. Mark this as Cursor2.
■ TLPX = Cursor2 – Cursor1 is the required result.

Cp – Clock positive waveform

Cn – Clock negative waveform
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Test 1.4.2 Clock Lane HS Entry: TCLK-PREPARE Value. Clock Lane HS Entry:
TCLK-PREPARE Value is calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

■ Obtain a differential clock signal as CnMinCp = Cn - Cp
■ Find the Low Speed UI, LS_UI (for Low Power region), VOL, and VOH.
■ Identify a falling edge in the CnMinCp waveform (the falling edge is taken

corresponding to 0.55 V limit). Identify a point on the Cn waveform
corresponding to the falling edge on CnMinCp. Mark this as Cursor1.

■ From Cursor1 move forward on Cn until you find a point lying below VOL.
From this point move forward on Cn until you find a point above VOH.

■ From this point traverse back until you find a point just above 0.070V. Mark
this as Cursor 2.

■ TCLK-PREPARE = Cursor2 – Cursor1 is the required result.

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.4.3 Clock Lane HS Entry: TCLK-PREPARE+TCLK-ZERO Value. Clock Lane
HS Entry: TCLK-PREPARE+TCLK-ZERO Value is calculated using the
following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

■ Obtain a differential clock signal as CnMinCp = Cn - Cp
■ Find the Low Speed UI, LS_UI (for Low Power region), VOL, and VOH.
■ Identify a falling edge in the CnMinCp waveform (the falling edge is taken

corresponding to 0.55 V limit). Identify a point on the Cn waveform
corresponding to the falling edge on CnMinCp. Mark the end of TCLK-
PREPARE as Cursor1.

■ Obtain VCMTX as, VCMTX= (Cp + Cn) / 2.
■ Traverse forward from Cursor1 and identify a point on Cn where Cn crosses

(or goes below) VCMTX. Mark this point as Cursor2.
■ TCLK-PREPARE + TCLK-ZERO = (Cursor2 – 3*UI – TCLK-PREPARE Begin) is the

required result.

Cp – Clock positive waveform

Cn – Clock negative waveform
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Test 1.4.4 Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1)). Clock Lane
HS-TX Differential Voltages (VOD(0), VOD(1)) are calculated using the
following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the waveform.
■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify all the HS regions in the input clock waveforms.
■ In the HS regions of the input clock waveforms identify a ‘10’ pattern to

measure VOD(0) and identify a ‘01’ pattern to measure VOD(1) (0 or 1 is a
region with about 1 UI interval length)

■ Measure VOD(0) and VOD(1) as the mean of all voltage samples at the exact
center of 0/1 bit respectively.

■ Average VOD(0) and VOD(1) across all instances of the pattern

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.4.5 Clock Lane HS-TX Differential Voltage Mismatch (VOD). Clock Lane HS-
TX Differential Voltage Mismatch (VOD) are calculated using the following
algorithm: 

■ Accept the following inputs:

■ Clock Lane signals Cp and Cn
■ Sampling rate

■ Identify the HS regions in the input clock waveform and estimate the UI.
■ In the HS regions of the input clock waveforms, identify a 10 pattern to

measure VOD(0) and identify an 01 pattern to measure VOD(1) (0 or 1 is a
region with about 1UI interval length)

■ VOD(0) and VOD(1) are measured as the mean of all voltage samples at the
exact center of 0/1 bit respectively.

■ VOD(0) and VOD(1) are averaged across all instances of the pattern
■ ΔVOD is calculated as, ΔVOD = VOD(1) –VOD(0)
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Test 1.4.6 Clock Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP),
VOHHS(DN)). Clock Lane HS-TX Single-Ended Output High Voltages
(VOHHS(DP), VOHHS(DN)) are calculated using the following algorithm:

where,

■ Acquire Clock Lane signals Cp and Cn, and the sampling rate.
■ Identify all the HS regions in the input clock waveform and estimate the UI.
■ In the HS regions of the input clock waveforms, identify a 011111 pattern on

Cp and Cn to measure VOHHSs(Cp) and VOHHS(Cn) respectively (11111 is
a region with about 5 UI interval length).

■ Calculate VOHHS(Cp) and VOHHS(Cn) as the measured mean of all voltage
samples between the centers of the 4th and 5th 1 bit respectively.

■ Averaage VOHHS(Cp) and VOHHS(Cn) across all instances of the pattern.

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.4.7 Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1), VCMTX(0)).
Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1), VCMTX(0))
are calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the waveform.
■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Create an VCMTX waveform as VCMTX = (Cp + Cn)/2 
■ Identify all the HS regions in the input clock and VCMTX waveforms.
■ At the Mid-point of each Clock UI, check if the clock is at Differential-0 or

Differential-1 state.
■ Obtain the corresponding point on the VCMTX waveform. If the clock is

Differential-0, the point is added to VCMTX(0), else if the clock is
Differential-1, the point added to VCMTX (1).

■ Average all values of VCMTX(0) and VCMTX(1).

where,

Cp – Clock positive waveform

Cn – Clock negative waveform
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Test 1.4.8 Clock Lane HS-TX Static Common-Mode Voltage Mismatch
(ΔVCMTX(1,0)). Clock Lane HS-TX Static Common-Mode Voltage Mismatch
(ΔVCMTX(1,0)) is calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the waveform.
■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Create an VCMTXwaveform as VCMTX = (Cp + Cn)/2 
■ Identify all the HS regions in the input clock and VCMTX waveforms.
■ At the Mid-point of each Clock UI, check if the clock is at Differential-0 or

Differential-1 state.
■ Obtain the corresponding point on the VCMTX waveform. If the clock is

Differential-0, the point is added to VCMTX(0), else if the clock is
Differential-1, the point added to VCMTX (1).

■ Average all values of VCMTX (0) and VCMTX (1) and calculate ∆VCMTX(1,0)=
(VCMTX (1) – VCMTX (0))/2.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.4.9 Clock Lane HS-TX Dynamic Common-Level Variations Between
50-450MHz (ΔVCMTX(LF)). Clock Lane HS-TX Dynamic Common-Level
Variations Between 50-450MHz (ΔVCMTX(LF)) is calculated using the
following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, Bandpass Filtered Clock Lane
signals FilteredCp and FilteredCn, and the sampling rate.

■ Identify all the HS regions in the Filtered input data waveforms using
Unfiltered Cp and Cn.

■ Find the minimum voltage in the filtered clock HS region, Vmin. Find the
maximum voltage in the Filtered clock HS region, Vmax

■ Compute Vpeak as, Vpeak = max(Vmax, abs(Vmin))

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

FilteredCp – Bandpass Filtered Clock positive waveform

FilteredCn – Bandpass Filtered Clock negative waveform
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Test 1.4.10 Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz
(ΔVCMTX(HF)). Clock Lane HS-TX Dynamic Common-Level Variations Above
450MHz (ΔVCMTX(HF)) is calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, Bandpass Filtered Clock Lane
signals FilteredCp and FilteredCn, and the sampling rate.

■ Identify all the HS regions in the Filtered input data waveforms using
Unfiltered Cp and Cn.

■ Find the minimum voltage in the filtered clock HS region, Vmin. Find the
maximum voltage in the Filtered clock HS region, Vmax

■ Compute Vrms as:
 

 

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

FilteredCp – Bandpass Filtered Clock positive waveform

FilteredCn – Bandpass Filtered Clock negative waveform

Test 1.4.11 Clock Lane HS-TX 20%-80% Rise Time (tR). Clock Lane HS-TX
20%-80% Rise Time (tR) is calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the waveform.
■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify all the HS regions in the input data waveforms.
■ Compute VOD(0) and VOD(1).
■ In the HS regions of the input data waveforms identify a ‘01’ pattern (is a

region alternating (low-high) with about 1UI interval length).
■ Measure Rise-time, tR (as time between 20%-80% of the VOD), on the

identified ‘01’ pattern
■ Average all values of tR.

where,

Cp – Clock positive waveform

Cn – Clock negative waveform
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Test 1.4.12 Clock Lane HS-TX 80%-20% Fall Time (tF). Clock Lane HS-TX
80%-20% Fall Time (tF) is calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn, and the waveform.
■ Identify the HS regions in the input clock waveform and estimate the UI.
■ Identify all the HS regions in the input data waveforms.
■ Compute VOD(0) and VOD(1).
■ In the HS regions of the input data waveforms identify a ‘10’ pattern (is a

region alternating (high-low) with about 1 UI interval length).
■ Measure Fall-time, tF (as time between 80%-20% of the VOD), on the

identified ‘10’ pattern.
■ Average all values of tF.

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.4.13 Clock Lane HS Exit: THS-TRAIL Value. Clock Lane HS Exit: THS-
TRAIL Value is calculated using the following algorithm: 

■ Acquire Clock Lane signals Clkp and Clkn(single-ended) or
Clkp(differential, Clkp – Clkn).

■ Identify the LP regions using input data waveform. Let the number of LP
regions be N.

■ From the beginning of every LP region, move backward in the waveform
until the absolute diff(Clkp-Clkn) is greater than 0.1v. Let these points be
p(i), i=0 to (N-1).

From p(i), move forward in waveform until the absolute value of the
diff(Clkp-Clkn) is less than 0.07v. Let these points be q(i). q(i) marks the end
of trail region.

■ From p(i) move backward in waveform until the point where single-ended
signals Clkp and Clkn cross each other. Let this point be r(i). r(i) marks the
start of trail region.

Trail_Duration(i) = [p(i) – r(i)]
■ Compute the mean of trail durations observed at all HS to LP transitions.

TrailMean = (1/N)*(Sum(Trail_Duration(i))

 Reference

TekExpress D-PHY Printable Application Help 251



Test 1.4.14 Clock Lane HS Exit: 30%-85% Post-EOT Rise Time (TREOT). Clock Lane
HS Exit: 30%-85% Post-EOT Rise Time (TREOT) is calculated using the
following algorithm: 

■ Acquire single-ended clock lane signals Clkp and Clkn.
■ Identify the LP regions using input data waveform. Let the number of LP

regions be N.
■ From the beginning of every LP region, move backward in the waveform

until the absolute diff(Clkp-Clkn) is greater than 0.1V. Let this point be p(i),
i=0 to (N-1). From p(i), move forward in waveform until the absolute value
of the diff(Clkp-Clkn) is less than 0.07V. Let this point be q(i). q(i) marks the
start of TREOT region.

■ From q(i) move forward in waveform until the point where amplitude of
single-ended signal Clkp goes greater than 0.88 volts. Let this point be r(i).
r(i) marks the end of TREOT region.

TREOT_Duration(i) = [r(i) – q(i)]
■ Compute the mean of TREOT durations observed at all HS to LP transitions.

Test 1.4.15 Clock Lane HS Exit: TEOT Value. Clock Lane HS Exit: TEOT Value is
calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn.
■ Estimate the clock UI.
■ Compute Ths-Trail as in Test 1.4.13.
■ Compute Treot as in Test 1.4.14.
■ Compute Teot as, TEOT = Ths-Trail + Treot..

Test 1.4.16 Clock Lane HS Exit: THS-EXIT Value. Clock Lane HS Exit: THS-EXIT
Value is calculated using the following algorithm: 

■ Acquire Clock Lane signals Cp and Cn.
■ Identify the LP regions using input clock waveform.
■ Mark the beginning of every LP region (corresponds to the end of Ths-Trail)

as the Start cursor.
■ Mark the End cursor at the point where the Cp or Cn (whichever is first)

falling edge goes below 550 mV.
■ Compute Ths-Exit as, THS-EXIT = End cursor – Start cursor.
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Test 1.4.17 Clock Lane HS Clock Instantaneous (UIINST). Clock Lane HS Clock
Instantaneous (UIINST) is calculated using the following algorithm: 

■ Accept the following inputs:

■ Clock Lane signals Cp and Cn
■ Sampling rate

■ Identify all the HS regions in the input clock waveforms
■ In the HS regions of the input clock waveforms, identify all the edges.

Comput the duration of each period as the edge-to -edge transition duration
(that is the time between a rise and the subsequent fall or fall and the
subsequent rise, taken with reference to 50% of peak)

■ Compute the following as results:

■ HSUIMean = mean of all periods computed above
■ HSUIMinimum = minimum value of the periods computed above
■ HSUIMaximum = maximum value of the periods computed above

Test 1.4.18 Clock Lane HS Clock Delta UI (ΔUI). Clock Lane HS Clock Delta
UI(ΔUI) is calculated using the following algorithm:

■ Accept the following inputs:

■ Clock Lane signals Cp and Cn
■ Sampling rate

■ Identify all the HS regions in the input clock waveforms
■ In the HS regions of the input clock waveforms, identify all the edges.

Compute the duration of each period as the edge-to -edge transition duration
(that is the time between a rise and the subsequent fall or fall and the
subsequent rise, taken with reference to 50% of peak)

■ Take the inverse of all the UI values computed which is nothing but the array
of frequencies.

■ Now apply a double-pole (second order) Butterworth lowpass filter with a
-3dB cutoff frequency of 2.0 MHz to filter the UI data to remove the high
frequency noise/error components.

■ The resulting waveform that is produced at the output of the test filter will
then be converted to units of percent, to produce the ΔUI values.

■ The peak maximum and peak minimum values will be observed, and the one
with the greater absolute value will be reported as the result for that burst.

■ If multiple bursts are observed, the peak value across all bursts will be
reported as the final result.
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Group 5 tests Test 1.5.1 HS Entry TCLK PREValue. HS Entry TCLK PREPValue is calculated
using the following algorithm: 
■ Acquire the Dp and Dn waveforms by setting the Transition trigger from LP

to HS mode (LP11-10) on the oscilloscope.
■ Using post processing, traverse the Cp and Cn waveforms and find the

position corresponding to Cursor 3. Traverse the Dp and Dn waveforms and
find the position corresponding to Cursor 4 as below:
■ Subtract the Cp and Cn waveforms to obtain Cp–Cn.
■ In the LP signaling sequence, find in Cp–Cn, the first rising edge and

successive falling edge. Marker 1 is the point where the falling edge
touches 550 mV.

■ Compute VOLHS:
■ Find the high speed sequence in the input clock waveforms.
■ Find the highest and the lowest voltage values in the high speed

sequence. The mode of all the values greater than 50% of the peak-to-
peak is the VOHHS and the mode of all the values less than 50% of the
peak-to peak is the VOLHS.

■ Find the Cursor 3 position.
■ From the point corresponding to Marker 1 on Cn, traverse to the right of

Cn waveform and find a point that is less than or equal to the VOLHS.
Mark this point as Marker 2.

■ From Marker 2, traverse both the Cn and Cp waveforms and find the first
point which is greater than or equal to VOHHS on either of the Cn or Cp
waveforms. Mark this point as Marker 3.

■ On the waveform where the Marker 3 point was found, traverse to the
left of the waveform until a point less than or equal to 70 mV is located.
This is Marker 4.

■ On the waveform where the point corresponding to Marker 3 was found,
traverse to the right and find a point where the voltage is less than or
equal to (VOHHS +VOLHS)/2. This is Marker 5.

■ Starting from Marker 5, on the same waveform where the point
corresponding to Marker 5 was found, traverse further and find a point
where the voltage is greater than or equal to (VOHHS +VOLHS)/2. This is
Marker 6. Marker 5–Marker 6 and is almost 1 High speed UI. Hence
Marker 5 – (Marker 6–Marker 5) is the end point of TCLK-ZERO. Call this
Marker 7.

■ Cursor 3 = Marker 7.
■ On the Dn and Dp waveforms, find the point corresponding to Marker 7 and

check if the value of that point is greater than 0.8 V. If yes, continue with the
following steps, else, the signal is not correct.

■ On the Data waveform, find a point corresponding to Marker 7. From this
point, traverse to the right and find the first falling edge. The point at which
this falling edge crosses 550 mV is Cursor 4.

■ The time between Cursor 3 and Cursor 4 is TCLK-PRE.

where,

Dp – Data positive waveform
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Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform
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Test 1.5.2 HS Exit TCLK POSTValue. HS Exit TCLK POSTValue is calculated
using the following algorithm: 

■ Acquire Cp, Cn, Dp, and Dn waveforms by setting the Transition trigger
from LP to HS mode (LP11-10) on oscilloscope.

■ Using post processing, traverse the Dp and Dn waveforms and find the
position corresponding to Cursor 1. Traverse the Cp and Cn waveforms and
find the position corresponding to Cursor 2 as below:

■ Compute VOL and VOH for the clock and data waveform.
■ Find the rising edges on the clock waveform. From the point where the

first rising edge is found, traverse backwards on that waveform and find
the point where either of the Cp or Cn waveforms’ voltage level reaches
VOL. This point is Marker 1. At Marker 1 position, one of Cp and Cn
voltages is greater than the other. Let us say Cn value is greater than Cp
value at this point.

■ Traverse backwards from Marker 1 and find on the clock waveforms
where Cp value becomes greater than Cn. This point is Marker 2.

■ Continue traversing backwards on the clock waveforms and find a point
where Cn value becomes greater than Cp.

■ Cursor 2 = Marker 2 + (Marker 2–Marker 3).
■ At a point corresponding to Cursor 2, check if the data waveform value is

greater than 0.8 V. If yes, then proceed, else the signal is not correct.
■ From the point corresponding to Cursor 2 position on Data waveform,

traverse backwards and find the point where a rising edge value becomes
either equal to or just less than VOL. This point is Cursor 1.

■ The time between Cursor 1 and Cursor 2 is TCLK-POST as shown in the
following figure.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform
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Test 1.5.3 HS Clock Rising Edge Alignment to First Payload Bit . HS Clock Rising
Edge Alignment to First Payload Bit is determined by visual verification. 

Test 1.5.4 Data-to-Clock Skew (TSKEW[TX}). Data-to-Clock Skew is calculated
using the following algorithm: 

■ Acquire Data Lane signals Dp and Cn.
■ Acquire Clock Lane signals Cp and Cn (if single ended) or

CDiff(differential).
■ Compute differential data (Dp-Dn) and differential clock (CDiff = Cp-Cn)

signal. Determine HS regions of differential data waveform (Dp-Dn).
■ Using the HS regions, filter out the HS part in the differential data

(Diffdata_HS) and differential clock signal (Diffclk_HS). Determine HS
edges present in Diffdata_HS and Diffclk_HS.

■ Mark the data edge position as t1. Determine the clock edge which occurs
immediately after the data edge. Let the clock edge position be t2. Data to
clock skew(i) = (t2 — t1), where I represents the data edge. Do this for each
data edge.

■ Compute the maximum, minimum, and mean of the data to clock skew.
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Test 1.5.5 Initial HS Skew Calibration Burst (TSKEWCAL-SYNC, TSKEWCAL). Initial
HS Skew Calibration Burst is calculated using the following algorithm: 
 

 
■ Acquire Dp and Dn waveform by setting the Transition trigger from LP to

HS mode on the oscilloscope.
■ Using post processing, traverse the Dp waveform and find the

Cursor1,Cursor2 and Cursor3 positions.
■ From the HS Signaling subtract the Dp and Dn waveforms to obtain Dp-Dn.
■ Take the zero-crossing points of the differential waveform.
■ Compute the mean UI value across the entire burst.
■ The differential waveform which takes the pattern of 16UI (16 1’s pattern)

which comes after HS_Exit is measured as the deskew sync pattern (0xFFFF,
TSKEWCAL-SYNC)

■ Start of 16UI pattern or End of HS Exit is marked as Cursor1.
■ End of 16UI pattern is marked as Cursor2.
■ After the 16UI pattern ends, compute the clock pattern(01010101….) of

minimum duration 2^15 UI(32768 UI)
■ End of the 2^15 UI pattern is marked as Cursor3.
■ Cursor2 – Cursor1 gives the length of TSKEWCAL-SYNC
■ Cursor3 – Cursor2 gives the length of TSKEWCAL
■ For all Data Lanes, the value of TSKEWCAL-SYNC will be 16*UI +/-

0.25UI (where UI is the mean UI value from the burst) in order to be
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considered conformant. Also, TSKEWCAL will be greater than or equal to
2^15 UI (32768 UI) in order to be considered conformant.

■ Compute the TSKEWCAL-SYNC and TSKEWCAL values, as described
above.

■ Repeat the previous steps for Data Lanes 1, 2, and 3 (if DUT implements
multiple Data Lanes).

Test 1.5.6 Periodic HS Skew Calibration Burst (TSKEWCAL-SYNC, TSKEWCAL).
Periodic HS Skew Calibration Burst is calculated using the following algorithm: 

■ Acquire Dp and Dn waveform by setting the Transition trigger from LP to
HS mode on the oscilloscope.

■ Using post processing, traverse the Dp waveform and find the
Cursor1,Cursor2 and Cursor3 positions.

■ From the HS Signaling subtract the Dp and Dn waveforms to obtain Dp-Dn.
■ Take the zero-crossing points of the differential waveform.
■ Compute the mean UI value across the entire burst.
■ The differential waveform which takes the pattern of 16UI (16 1’s pattern)

which comes after HS_Exit is measured as the deskew sync pattern (0xFFFF,
TSKEWCAL-SYNC)

■ Start of 16UI pattern or End of HS Exit is marked as Cursor1.
■ End of 16UI pattern is marked as Cursor2.
■ After the 16UI pattern ends, compute the clock pattern(01010101….) of

minimum duration 2^12 UI(4096 UI)
■ End of the 2^12 UI pattern is marked as Cursor3.
■ Cursor2 – Cursor1 gives the length of TSKEWCAL-SYNC
■ Cursor3 – Cursor2 gives the length of TSKEWCAL
■ For all Data Lanes, the value of TSKEWCAL-SYNC will be 16*UI +/-

0.25UI (where UI is the mean UI value from the burst) in order to be
considered conformant. Also, TSKEWCAL will be greater than or equal to
2^12 UI (4096 UI) in order to be considered conformant.

■ Compute the TSKEWCAL-SYNC and TSKEWCAL values, as described
above.

■ Repeat the previous steps for Data Lanes 1, 2, and 3 (if DUT implements
multiple Data Lanes).

Group 6 tests Test 1-6-1 INIT: LP-TX initialization period (TINIT,MASTER). The Conformance Test
Suite (CTS) mentions that TINIT can be a protocol dependent parameter, and
generation and controlling it can be implemented in the protocol layer. Therefore
this test may not be applicable for all DUTs.
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Test 1-6-2 ULPS entry: Verification of clock lane LP-TX ULPS support. This test is
applicable for clock lane of Master DUTs only. Sometimes it is difficult to
capture the ULPS entry sequence, as measuring intervals can be longer than the
Scope memory depth. For this reason, ‘Horizontal Delay’ is used in Trigger.

You may need to use this value in ‘User Defined mode’ to perform this test after
determining the amount of delay need for the trigger for a particular DUT.

Test 1-6-3 ULPS exit: Transmitted TWAKEUP interval. Same as in Test 1.6.1.

Test 1-6-4 BTA: TX-Side TTA-GO interval value. These tests are semi-automatic as
the drive overlap period cannot be reliably determined algorithmically. These
tests are informative only.

After the test is complete, the user is prompted to place the cursors appropriately.
The application adds the time difference between the cursors to the report.

Test 1-6-5 BTA: RX-Side TTA-SURE interval value. Same as in Test 1.6.4.

Test 1-6-6 BTA: RX-Side TTA-GET interval value. Same as in Test 1.6.4.

Shortcut keys
The following table lists the short cut keys to access the application:

Menu Shortcut keys
File Alt + F
New Session Ctrl + N
Open Session Ctrl + O
Save Session Ctrl + S
Save Session As Alt + F + A
Save Report As Alt + F + R

Ctrl + R
Print Preview Report Alt + F + V

Ctrl+ V
Print Report Ctrl + P
Exit Ctrl + X
View Alt + V
Log Ctrl + L
Tools Alt + T
Instrument Bench Ctrl + I
Help Alt + H
TekExpress Help (F1) Alt + H + H
About TekExpress Alt + H + A
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Error codes
The following table lists the error codes used in the application:

Error code Description
50111 Waveform file not found
50001 Could not find HS region
50002 Could not find LP region
50003 HS UI could not be computed
50004 Pattern 011111/100000 not found
50006 Pattern 111000 not found
50007 Pattern 000111 not found
50008 Possible improper clock
50009 Could not find HS Trail
50010 Could not find TREOT
50011 Rising edges not found
50012 Falling edges not found
50013 TLPX region not found
50014 THS-Prepare region not found
50015 THS-Prepare-Zero region not found
50016 HS-Exit not found
50017 Proper LP Edges not found
50018 Clock-Pre region not found
50019 Clock-Post region not found
50020 LP-00 region not found
50021 Skew Cal Sync of Length 16 UI not Found
50022 Initial Skew Cal Sync of Length 32768 UI not

Found
50023 Period Skew Cal Sync of Length 4096 UI not

found
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Oscilloscope setup
Four channel with Data as Trigger

Parameter Value
Vertical Scale (mV) 200 
Vertical Position for Data (div) –2.6 
Vertical Position for Clock (div)
Single Ended
Differential

 
–2.6 
+2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 8 
Sample Rate (GS/s) 12.5 
Record Length 1000000 
Trigger Type Transition
Trigger Source Data Source (Dp/Dn)
Trigger Upper Level (V) 1 
Trigger Lower Level (V) 0.05 
Trigger Time (pS) 500 
Trigger Transition Greater Than
Trigger Slope Positive
Trigger If Violation Occurs

Four channel with Clock as Trigger

Parameter Value
Vertical Scale (mV) 200 
Vertical Position for Data (div) –2.6 
Vertical Position for Clock (div)
Single Ended
Differential

 
–2.6 
+2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 8 
Sample Rate (GS/s) 12.5 
Record Length 1000000 
Trigger Type Transition
Trigger Source Clock Source (Clkp/Clkn)
Trigger Upper Level (V)
Single Ended
Differential

 
1 
–0.05 

Trigger Lower Level (V)
Single Ended
Differential

 
0.05\1 
–1 

Reference  
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Parameter Value
Trigger Time (pS) 500 
Trigger Transition Greater Than
Trigger Slope
Single Ended
Differential

 
Positive
Negative

Trigger If Violation Occurs

Two channel with Data as Trigger

Parameter Value
Vertical Scale (mV) 200 
Vertical Position for Data (div) –2.6 
Vertical Offset (V) 0 
Horizontal Scale (us) 8 
Sample Rate (GS/s) 12.5 
Record Length 1000000 
Trigger Type Transition
Trigger Source Data Source (Dp/Dn)
Trigger Upper Level (V) 1 
Trigger Lower Level (V) 0.05 
Trigger Time (pS) 500 
Trigger Transition Greater Than
Trigger Slope Positive
Trigger If Violation Occurs

Two channel with Clock as Trigger

Parameter Value
Vertical Scale (mV) 200 
Vertical Position for Clock (div)
Single Ended
Differential

 
–2.6 
+2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 8 
Sample Rate (GS/s) 12.5 
Record Length 1000000 
Trigger Type Transition
Trigger Source Clock Source (Clkp/Clkn)
Trigger Upper Level (V)
Single-Ended
Differential

 
1 
–0.05 

 Reference
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Parameter Value
Trigger Lower Level (V)
Single-Ended
Differential

 
0.05\1 
–1 

Trigger Time (pS) 500 
Trigger Transition Greater Than
Trigger Slope
Single-Ended
Differential

 
Positive
Negative

Trigger If Violation Occurs

Setup for Clock Continuous Mode

Parameter Value
Vertical Scale (mV) 200 
Vertical Position for Data/Clock (div)
Single Ended
Differential

 
–2.6 
+2.6 

Vertical Offset (V) 0 
Horizontal Scale (us) 8 
Sample Rate (GS/s) 12.5 
Record Length 1000000 
Trigger Type Edge
Trigger Source Data Source (Dp/Dn)/Clock Source (Clkp/Clkn)
Trigger Level (V)
Single Ended
Differential

 
200 mV
0 V

Reference  
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Button

Configure, 24
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CheckSessionSaved(), 208
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Cancel button, 27
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Save button, 27

Connect(), 173
Connections
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113
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D
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LockSession(), 174

M
Mapping My TekExpress folder, 11
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automatic, 26, 45
manual, 26, 45

Menu
File, 15
Help, 18
Tools, 16
View, 16

Minimum system requirements, 6
My TekExpress, 39
My TekExpress folder, 8

O
Oscilloscopes supported, 5
Overview, 1

P
Perform analysis

using live waveform files, 33
Program example, 219
Proxy Object

Client, 167

Q
QueryStatus(), 199

R
Reactivating License, 9
RecallSession(), 208
Related Documentation, 2
Report panel overview, 38
Resizing the application, 14
Run button, 14
Run(), 196

S
SaveSession(), 208

SaveSessionAs(), 208
Select Test(s)

Group 1, 19
Group 2, 19
Group 3, 20
Group 4, 21
Group 5, 21

Selecting acquisition source, 36
Selecting connected instruments, 32
SelectTest(), 186, 188
SendResponse(), 200
Session folder, 39
SetAcquireParameter(), 193
SetAnalyzeParameter(), 193
SetDutId(), 177
SetGeneralParameter(), 179, 189
SetTimeOut(), 197
SetVerboseMode(), 175
Shortcut keys, 260
Signal Path Compensation (SPC), 11
Starting the application, 13
Stop(), 196

T
Technical support, 3
TekVISA Instrument Manager, 31
Temperature chamber testing

filter file, 26, 45
Test limits, 29
Test(s)

Report, 38
TestStand Client example, 221
Tools

Instrument Bench, 17
TransferImages(), 205
TransferReport(), 204
TransferWaveforms(), 205

U
UnlockSession(), 210
Untitled Session, 8
USB dongle, 13
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W
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